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About this 
guide

The Unity Installation Guide contains instructions for installing a 
Unity™ server in four different configurations. 

Chapter 2 defines the Unity configurations and contains an 
installation task list for each configuration, as well as a task list 
for installing ActiveFax™ for Unity on a separate server. The 
tasks reference sections in the rest of the book that contain 
detailed instructions. 

The Unity Installation Guide focuses on Unity. It does not provide 
extensive information about Microsoft® Exchange Server, Win-
dows NT® Server, or Windows® 2000 Server. If you are installing 
Unity as an e-mail server or on a network with existing Exchange 
servers, you need a working knowledge of Exchange and Win-
dows NT/2000.

You can find compliance information for third-party electronic 
devices in the manufacturer’s documentation included in the 
Unity package. Do not use a third-party manufacturer’s docu-
mentation to install, upgrade, or manage Unity. Refer only to 
Unity documentation to install, upgrade, and manage Unity. 

In order to receive assistance from Technical Support, you must 
have passed the Unity training courses. 

Documentation conventions
The Unity Installation Guide uses the following conventions:

User input  Information that the user types appears in Courier:

Example Administrator

Key names  Key names appear in capital letters: ENTER. Keys 
that must be pressed simultaneously are joined by a “+”: 
CTRL+ALT+DELETE. 
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Cascading selections  The “>” symbol separates the selections 
you make: on menus (Programs > Administrative Tools (Com-
mon) > User Manager); in the navigation levels of the Unity 
administration interface (Call Management > Call Handlers > Profile); 
and in menu trees (UnityOrg > UnitySite > Configuration). 

Installation Guide navigation  The “Do this section?” table (exam-
ple at left) at the beginning of each section lists the Unity config-
urations as well as ActiveFax on a separate server, and identifies 
whether the section applies to a configuration. When the section 
does not apply to a configuration, the table lists a reference to 
the correct section for that configuration.

The “Next section” table (example below) at the end of each sec-
tion lists the configurations and a reference to the section you do 
next.

Next section

TURNKEY SYSTEM

Voice mail only Starting the Unity server and logging on to 
Windows NT/2000, page 44

Voice mail with LAN admin Starting the Unity server and logging on to 
Windows NT/2000, page 44

Unified, one Exchange server

Unity server is a PDC Starting the Unity server and logging on to 
Windows NT/2000, page 44

Unity server is a member server Installing Windows NT Server, page 49

Unified, existing Exchange site Installing Windows NT Server, page 49

COMPONENT SYSTEM

All configurations Installing Windows NT Server, page 49

ACTIVEFAX SERVER

Installing Windows NT Server, page 49

DO THIS SECTION?

TURNKEY 
SYSTEM

YES NO
see

page

Voice mail only ✓
Voice mail with LAN admin ✓
Unified, one Exchange server

Unity server is a PDC ✓
Unity server is a member 

server
49

Unified, existing Exchange site 49

COMPONENT 
SYSTEM

Voice mail only 49

Voice mail with LAN admin 49

Unified, one Exchange server 49

Unified, existing Exchange site 49

ACTIVEFAX SERVER

49
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New in this 
guide

The Unity Installation Guide documents a number of new 
features and includes some improvements.

Item Description Documentation of item

A more intuitive Unity Setup 
program

The Setup program:
◆ Can be displayed in multiple languages.
◆ Checks for the necessary Exchange config-

uration and rights before installing Unity.
◆ Allows you to install ActiveFax on a sepa-

rate server.

“Installing Unity and 
ActiveFax,” on page 69

A different process for installing 
Windows NT Server

“Installing Windows NT 
Server,” on page 49

A different process for installing 
Exchange Server

“Installing Exchange,” on 
page 60

More supported voice boards Unity now supports:
◆ Dialogic® D/41E™ PCI
◆ Dialogic D/120JCT-LS™

◆ Dialogic D/160SC™, which works with the 
Voice Technologies Group™ VoiceBridge 
2000™ feature-set board

◆ Dialogic D/240PCI-T1™
◆ Natural MicroSystems™ AG 2000

Appendix A, “Voice and 
fax boards,” on page 115

Reorganized and expanded doc-
umentation

Includes a clearer path through the book for 
each of the four configurations in which Unity 
can be installed.

“About this guide,” on 
page 2

A new chapter on upgrading 
hardware and software

Chapter 5, “Upgrading 
hardware and software,” 
on page 99
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Introducing 
Unity

Unity provides a range of capabilities—from basic voice messag-
ing to unified messaging—by working with the following soft-
ware:

Windows NT Server or Windows 2000 Server  Windows NT 
Server version 4.0 or Windows 2000 Server is the required oper-
ating system for Unity.

Exchange Server  Unity uses Exchange Server version 5.5 for 
address directory information and for message storage. 
Exchange provides a single address directory for voice messages, 
e-mail, and faxes, and communicates this information with 
Unity by using LDAP. Messages are accessed by using MAPI. 
Exchange also provides gateway access to other messaging 
systems.

ActiveFax for Unity  ActiveFax, the optional fax component of 
Unity, provides fax server functionality on the Unity server or on 
a separate server.

Fax server software  When an installation includes integrating a 
third-party fax server with Unity, the fax server software is 
installed on the fax server. Installation and administration are 
controlled by the fax server software and not by Unity.

Internet Explorer  Microsoft Internet Explorer version 4.01 or 
later is required for Web browser access to the Unity administra-
tion pages and to subscribers’ ActiveAssistant™ pages. Version 5 
or later is required to access the Unity Status Monitor. (Netscape 
Navigator® is not supported.)

Internet Information Server  Microsoft Internet Information 
Server version 4.0 hosts the Active Server Pages used for Unity 
administration. We recommend that the Unity server not be used 
to host any other Web pages.

Unified messaging clients  Microsoft Outlook® 97, Outlook 98, 
and Outlook 2000 support ViewMail® for Microsoft Outlook. With 
ViewMail, voice messages appear in the Outlook Inbox, and are 
played and recorded by using a form that has VCR-like controls. 
(Without ViewMail, Outlook behaves like the e-mail clients 
described under the following “E-mail clients.”)

Continued
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Continued

Introducing Unity E-mail clients  Supported e-mail clients—such as Microsoft Out-
look Express, IMAP4 clients, POP3 clients, and Exchange’s Web 
messaging client—also provide access to voice messages. Voice 
messages appear as e-mail messages with attached WAV files.

Windows messaging client  Outlook 97, Outlook 98, or 
Outlook 2000 must be running on the Unity server for 
troubleshooting.

The following illustration shows a full-featured Unity 
installation:

NETWORK

PUBLIC 
PHONE 
NETWORK

• Unity

• Exchange Server

• Internet Explorer

• Internet Information 
Server

• Windows 
NT/2000 Server

• ActiveFax (optional)

UNITY 
SERVER

E-MAIL 
SERVER

UNITY 
ADMINISTRATOR

INTERNET
SUBSCRIBERS

• E-mail client

PHONE 
SYSTEM

DID line

Mobile 
phone

Phone

Fax

SUBSCRIBER

• E-mail client

FAX SERVER (optional)

• ActiveFax or third-party 
fax software

• Windows NT/2000

• Exchange Server

• Windows 
NT/2000 Server

INTERNET
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Unity in a multisite Exchange network
Exchange servers in the same site automatically route messages 
and replicate directories. For message routing and directory rep-
lication to occur among Exchange servers at different sites, site 
connectors must be set up by a Microsoft Certified System Engi-
neer (MCSE). 

If you are installing Unity in a multisite Exchange network in 
which site connectors have been set up, the Exchange message 
transfer agent will route voice messages automatically, according 
to the settings for e-mail. Exchange directories replicate as well.

An MCSE also can set up routing and replication between two 
stand-alone voice messaging servers, or set up connectors to 
other e-mail systems.

Unity and network operating systems
Although the Unity server must use Windows NT/2000 as an 
operating system, it can be connected to a network that uses 
another operating system, such as Novell® NetWare® or UNIX, as 
long as the network supports TCP/IP.
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Unity 
configurations

There are four ways to install Unity. The following lists describe 
the characteristics of each type of configuration.

Voice mail only

◆ The Unity server handles only voice messages.

◆ The Unity server is not connected to the network.

◆ Subscribers check messages only by phone.

◆ Unity administration must be performed at the Unity server.

◆ Subscribers do not have access to the Unity ActiveAssistant.

◆ Voice-mail and e-mail attributes, if any, on subscriber 
accounts must be administered separately.

Voice mail with LAN administration

◆ The Unity server can handle voice and fax messages.

◆ The Unity server is connected to the network, so it has 
access to network utilities, such as virus checking and 
backup.

◆ Subscribers check messages only by phone.

◆ Unity administration may be performed over the network.

◆ Subscribers have access to the Unity ActiveAssistant.

◆ Voice-mail and e-mail attributes, if any, on subscriber 
accounts must be administered separately.

◆ ActiveFax may be installed on the Unity server or on a sepa-
rate server.
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Unified messaging, one Exchange server
Cisco requires that anyone installing a Unity server as a unified 
messaging server be an MCSE. In this configuration, the Unity 
server is the only Exchange server in the site.

◆ The Unity server can handle voice, e-mail, and fax mes-
sages.

◆ The Unity server is connected to the network, so it has 
access to network utilities, such as virus checking and 
backup.

◆ Subscribers check messages by using the phone or an 
e-mail client such as Outlook, Eudora®, or Pegasus Mail.

◆ Unity administration may be performed over the network.

◆ Subscribers have access to the Unity ActiveAssistant.

◆ Voice-mail and e-mail attributes on subscriber accounts 
may be administered from a single location by using the 
Unity Administrator (the administration interface).

◆ ActiveFax must be installed on a separate server.

NOTE: The Unity Installation Guide does not provide information 
about installing the Unity server as an e-mail server, and technical 
support is not provided for e-mail.

✣❏■▼❉■◆❅❄✣❏■▼❉■◆❅❄✣❏■▼❉■◆❅❄✣❏■▼❉■◆❅❄
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Continued

Unity configurations Unified messaging in an existing Exchange site
Cisco requires that anyone installing a Unity server as a unified 
messaging server be an MCSE. In this configuration, the Unity 
server is connected to other Exchange servers in the same site or 
in multiple sites. 

◆ The Unity server can handle voice, e-mail, and fax mes-
sages. Messages are stored on other Exchange servers.

◆ The Unity server is connected to the network, so it has 
access to network utilities, such as virus checking and 
backup.

◆ Subscribers check messages by using the phone or an 
e-mail client such as Outlook, Eudora, or Pegasus Mail.

◆ Unity administration may be performed over the network.

◆ Subscribers have access to the Unity ActiveAssistant.

◆ Voice-mail and e-mail attributes on subscriber accounts 
may be administered from a single location by using the 
Unity Administrator (the administration interface).

◆ ActiveFax may be installed on the Unity server or on a 
separate server.
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Separate 
ActiveFax 
server

When ActiveFax is installed on a separate server, the server has 
the following characteristics.

◆ The ActiveFax server handles only fax messages.

◆ Fax messages are routed to the message store on the sub-
scribers’ Exchange home server; they are not saved on the 
ActiveFax server.

◆ The ActiveFax server is connected to the network, so it has 
access to network utilities, such as virus checking and 
backup.

◆ ActiveFax administration may be performed over the 
network.
CHAPTER 2: Installation overview 13



Turnkey and 
component 
systems

Unity can be purchased as a turnkey system or as a component 
system. Your installation tasks depend on the configuration and 
the type of system you are installing.

Turnkey system
A turnkey system comes with all voice and fax boards, Windows 
NT Server, Exchange Server, and Unity already installed.

When Windows NT was installed, the Unity server was config-
ured as a Windows NT primary domain controller (PDC). Set up 
this way, the Unity server can work either as a stand-alone voice 
messaging server or as a unified messaging server that provides 
voice, e-mail, and fax messages in the site.

A Unity turnkey system is shipped with the following settings:

Depending on the Unity configuration, you may need to reinstall 
Windows NT, Exchange, and Unity.

A Windows NT member server  You must reinstall all software 
because the type of server—PDC or member server—can be spec-
ified only when Windows NT is installed.

A PDC in an existing Exchange site  You must reinstall Exchange 
and Unity because the site name can be specified only at the 
time that Exchange is installed. To avoid possible problems with 
uninstalling and then reinstalling Exchange, we recommend that 
you reinstall all software.

NOTE: Microsoft Exchange Move Server wizard does not move 
Unity’s custom elements, such as call handlers and interview 
handlers, and is not supported.

A PDC in a new Exchange site  You do not need to reinstall soft-
ware unless you want to change any of the settings listed in the 
table above.

Setting Value

Windows NT server name Unity-PDC1

Windows NT domain name Unity

Exchange site name UnitySite

Exchange organization name UnityOrg
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Component system
For a component system, the Unity software is purchased from 
Cisco or from a Cisco dealer. The other required software, the 
server, voice and fax boards, and other components may also be 
purchased from Cisco or a Cisco dealer, or they may be pur-
chased from another vendor.

If you are installing Unity as a component system or if you are 
installing ActiveFax on a separate fax server, the Installation 
Guide documents how to install software on a server that came 
with a blank hard disk. If the appropriate version of Windows 
NT/2000 or other required software has already been installed, 
you can skip the corresponding Installation Guide section. See 
the “Next section” table at the end of the skipped section to 
determine which section you do next.
CHAPTER 2: Installation overview 15



Task list: 
Voice mail only

Turnkey system

1 Review the installer’s checklist. See page 28.

2 Export information from Repartee® or Replay® Plus. See 
page 31.

3 Install or reseat voice and fax boards. See page 33.

4 Set up the Unity server. See page 40.

5 Start the Unity server and log on to Windows NT. See 
page 44.

6 Change passwords. See page 45.

7 Create an Outlook user profile. See page 80.

8 Create an emergency repair disk. See page 82.

9 Configure Unity to work with the phone system. See 
page 86.

10 Program the phone system. See page 90.

11 Test the integration. See page 92.
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Component system

1 Review the installer’s checklist. See page 28.

2 Export information from Repartee or Replay Plus. See 
page 31.

3 Install or reseat voice and fax boards. See page 33.

4 Set up the Unity server. See page 40.

5 Install Windows NT/2000 Server. See page 49.

6 Install Exchange Server. See page 60.

7 Install Microsoft Data Access Components. See page 63.

8 Install other software. See page 64.

9 Find I/O addresses for VoiceBridge 2000 feature-set boards. 
See page 67.

10 Install Unity and ActiveFax. See page 69.

11 Create an Outlook user profile. See page 80.

12 Create an emergency repair disk. See page 82.

13 Configure Unity to work with the phone system. See 
page 86.

14 Program the phone system. See page 90.

15 Test the integration. See page 92.
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Task list: 
Voice mail 
with LAN 
administration

Turnkey system

1 Review the installer’s checklist. See page 28.

2 Export information from Repartee or Replay Plus. See 
page 31. 

3 Install or reseat voice and fax boards. See page 33.

4 Set up the Unity server. See page 40.

5 Start the Unity server and log on to Windows NT. See 
page 44.

6 Change passwords. See page 45.

7 Assign a static IP address (only if there is no DHCP server 
on the network). See page 47.

8 Confirm that the Unity server is getting an IP address. See 
page 54.

9 Set up fax ports for ActiveFax. See page 75.

10 Create an Outlook user profile. See page 80.

11 Create an emergency repair disk. See page 82.

12 Configure Unity to work with the phone system. See 
page 86.

13 Program the phone system. See page 90.

14 Test the integration. See page 92.
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Component system

1 Review the installer’s checklist. See page 28.

2 Export information from Repartee or Replay Plus. See 
page 31.

3 Install or reseat voice and fax boards. See page 33.

4 Set up the Unity server. See page 40.

5 Install Windows NT/2000 Server. See page 49.

6 Confirm that the Unity server is getting an IP address. See 
page 54.

7 Install Exchange Server. See page 60.

8 Install Microsoft Data Access Components. See page 63.

9 Install other software. See page 64.

10 Find I/O addresses for VoiceBridge 2000 feature-set boards. 
See page 67.

11 Install Unity and ActiveFax. See page 69.

12 Set up fax ports for ActiveFax. See page 75.

13 Create an Outlook user profile. See page 80.

14 Create an emergency repair disk. See page 82.

15 Configure Unity to work with the phone system. See 
page 86.

16 Program the phone system. See page 90.

17 Test the integration. See page 92.
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Task list: 
Unified 
messaging, 
one Exchange 
server

Turnkey system, 
Unity server is a Windows NT PDC

1 Review the installer’s checklist. See page 28.

2 Export information from Repartee or Replay Plus. See 
page 31.

3 Install or reseat voice and fax boards. See page 33.

4 Set up the Unity server. See page 40.

5 Start the Unity server and log on to Windows NT. See 
page 44.

6 Change passwords. See page 45.

7 Assign a static IP address (only if there is no DHCP server 
on the network). See page 47.

8 Confirm that the Unity server is getting an IP address. See 
page 54.

9 Set up fax ports for ActiveFax. See page 75.

10 Create an Outlook user profile. See page 80.

11 Create an emergency repair disk. See page 82.

12 Configure Unity to work with the phone system. See 
page 86.

13 Program the phone system. See page 90.

14 Test the integration. See page 92.
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Turnkey system, 
Unity server is a member server

1 Review the installer’s checklist. See page 28.

2 Export information from Repartee or Replay Plus. See 
page 31.

3 Install or reseat voice and fax boards. See page 33.

4 Set up the Unity server. See page 40.

5 Install Windows NT Server. See page 49.

6 Confirm that the Unity server is getting an IP address. See 
page 54.

7 Install Exchange Server. See page 60.

8 Install Microsoft Data Access Components. See page 63.

9 Install other software. See page 64.

10 Install Unity and ActiveFax. See page 69.

11 Set up fax ports for ActiveFax. See page 75.

12 Create an Outlook user profile. See page 80.

13 Create an emergency repair disk. See page 82.

14 Configure Unity to work with the phone system. See 
page 86.

15 Program the phone system. See page 90.

16 Test the integration. See page 92.

Continued
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Task list: 
Unified messaging, 

Continued

one Exchange server

Component system

1 Review the installer’s checklist. See page 28.

2 Export information from Repartee or Replay Plus. See 
page 31.

3 Install or reseat voice and fax boards. See page 33.

4 Set up the Unity server. See page 40.

5 Install Windows NT/2000 Server. See page 49.

6 Confirm that the Unity server is getting an IP address. See 
page 54.

7 Install Exchange Server. See page 60.

8 Install Microsoft Data Access Components. See page 63.

9 Install other software. See page 64.

10 Find I/O addresses for VoiceBridge 2000 feature-set boards. 
See page 67.

11 Install Unity and ActiveFax. See page 69.

12 Set up fax ports for ActiveFax. See page 75.

13 Create an Outlook user profile. See page 80.

14 Create an emergency repair disk. See page 82.

15 Configure Unity to work with the phone system. See 
page 86.

16 Program the phone system. See page 90.

17 Test the integration. See page 92.
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Task list: 
Unified 
messaging 
in an existing 
Exchange site

Turnkey system

1 Review the installer’s checklist. See page 28.

2 Export information from Repartee or Replay Plus. See 
page 31.

3 Install or reseat voice and fax boards. See page 33.

4 Set up the Unity server. See page 40.

5 Install Windows NT Server. See page 49.

6 Confirm that the Unity server is getting an IP address. See 
page 54.

7 Establish trust relationships (only if the Unity server is a 
Windows NT PDC). See page 56.

8 Add account permissions. See page 58.

9 Install Exchange Server. See page 60.

10 Install Microsoft Data Access Components. See page 63.

11 Install other software. See page 64.

12 Install Unity and ActiveFax. See page 69.

13 Set up fax ports for ActiveFax. See page 75.

14 Create an Outlook user profile. See page 80.

15 Create an emergency repair disk. See page 82.

16 Configure Unity to work with the phone system. See 
page 86.

17 Program the phone system. See page 90.

18 Test the integration. See page 92.

Continued
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Task list: Unified 
messaging 
in an existing 

Continued

Exchange site

Component system

1 Review the installer’s checklist. See page 28.

2 Export information from Repartee or Replay Plus. See 
page 31.

3 Install or reseat voice and fax boards. See page 33.

4 Set up the Unity server. See page 40.

5 Install Windows NT/2000 Server. See page 49.

6 Confirm that the Unity server is getting an IP address. See 
page 54.

7 Establish trust relationships (only if the Unity server is a 
Windows NT PDC or Windows 2000 domain controller). See 
page 56.

8 Add account permissions. See page 58.

9 Install Exchange Server. See page 60.

10 Install Microsoft Data Access Components. See page 63.

11 Install other software. See page 64.

12 Find I/O addresses for VoiceBridge 2000 feature-set boards. 
See page 67.

13 Install Unity and ActiveFax. See page 69.

14 Set up fax ports for ActiveFax. See page 75.

15 Create an Outlook user profile. See page 80.

16 Create an emergency repair disk. See page 82.

17 Configure Unity to work with the phone system. See 
page 86.

18 Program the phone system. See page 90.

19 Test the integration. See page 92.
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Task list: 
ActiveFax on a 
separate server

Component system

1 Review the installer’s checklist. See page 28.

2 Install or reseat fax boards. See page 33.

3 Set up the ActiveFax server. See page 40.

4 Install Windows NT/2000 Server. See page 49.

5 Confirm that the ActiveFax server is getting an IP address. 
See page 54.

6 Establish trust relationships (only if the ActiveFax and 
Unity servers are in different domains). See page 56.

7 Install ActiveFax. See page 69.

8 Set up fax ports for ActiveFax. See page 75.
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Installer’s 
checklist

Basic requirements

◆ The Unity Integration Guide, if provided (the guide is pro-
vided for some phone systems; see the list on page 90).

◆ A Unity system key that enables the appropriate integration, 
number of voice and fax ports, and other options.

◆ Three blank 3.5" 1.44 MB disks.

◆ The necessary cables, line splitters, and adapters to connect 
the voice boards to the phone system.

◆ A test phone.

◆ A record of the previous voice messaging system configura-
tion, including extensions, transfer settings, and caller 
input settings. If the site had no previous voice messaging 
system, then you need a list of extensions.

Requirements for a component system

◆ A server that meets Unity specifications. 

◆ Installation discs for Microsoft Windows NT Server 4.0 or 
Windows 2000. For Windows NT, you also need Service 
Pack 6a.

◆ Installation discs for Microsoft Exchange Server (Standard 
Edition) version 5.5 or for Voice Mail Run-Time Edition of 
Exchange Server, and the necessary Client Access Licenses. 
You also need Service Pack 3.

◆ Microsoft Data Access Components version 2.5 or later 
(available on the Unity installation discs).

◆ Microsoft Internet Explorer version 5.0 or later.

◆ Symantec® pcAnywhere® version 9.0 or later.

◆ Symantec Norton Utilities™ version 2.0 or later (install only 
Speed Disk™ and Norton Disk Doctor™).

DO THIS SECTION?

TURNKEY 
SYSTEM

YES NO
see

page

All configurations ✓

COMPONENT 
SYSTEM

All configurations ✓

ACTIVEFAX SERVER

✓
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Requirements for a separate ActiveFax server

◆ A server that meets ActiveFax specifications.

◆ Installation discs for Microsoft Windows NT Server 4.0, 
Windows NT Workstation, or Windows 2000. For Windows 
NT Server or Workstation, you also need Service Pack 6a.

Requirements for unified messaging

◆ An understanding of the network topology, including the 
location of any other Exchange servers.

◆ The Exchange organization name.

◆ The Exchange site name.

◆ The names of any Windows NT/2000 domains on the 
network.

◆ An understanding of any trust relationships that must be 
set up among domains. (You may need to establish trust 
relationships between the Unity server’s domain and other 
domains.)

◆ Access to the administrator account on each domain.

◆ A backup of any Exchange or Windows NT/2000 servers (in 
the unlikely event you need to restore data).

Requirements for remote administration

◆ An understanding of how IP addresses are assigned on the 
network.

◆ Any restrictions on the IP addresses that can and cannot 
access the Unity Administrator.

◆ Any required security precautions.

Continued
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Continued

Installer’s checklist Next section

TURNKEY SYSTEM

All configurations Exporting information from Repartee or 
Replay Plus, page 31 

COMPONENT SYSTEM

All configurations Exporting information from Repartee or 
Replay Plus, page 31 

ACTIVEFAX SERVER

Installing or reseating voice and fax boards, 
page 33 
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Exporting 
information 
from Repartee 
or Replay Plus 

If the previous voice messaging system was not a Repartee or 
Replay Plus system, skip to the next section, “Installing or 
reseating voice and fax boards,” on page 33. 

For an upgrade to Unity from Repartee version 7.40 or later or 
from Replay Plus version 6.7 or later, the following subscriber 
information from the previous system can be used: 

◆ Names

◆ Extensions

◆ Call transfer settings

In this section, you export the subscriber information to disk 
for later use. The information is imported when subscribers 
are added. (Subscriber information also can be imported from 
Exchange and from phone systems and other voice messaging 
systems that can generate comma-delimited files.)

To export from Repartee version 7.40 or later 

a At the Banner screen, press F2.

b Select “Reports.”

c Select “Directory reports.”

d Select “Extension report.”

e Select “Copy.”

f Insert a blank disk in drive A.

g Specify a drive letter and file name, for example, 
A:\Extensio.rpt, and save the report to the disk.

h Remove the disk and set it aside for later use.

Continued

DO THIS SECTION?

TURNKEY 
SYSTEM

YES NO
see

page

All configurations ✓

COMPONENT 
SYSTEM

All configurations ✓

ACTIVEFAX SERVER

33
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Exporting 
information from 
Repartee or Replay 

Continued

Plus

To export from Replay Plus version 6.7 or later 

a At the Banner screen, click the Screen Menu icon.

b Click “System reports.”

c Under “Directory,” click “All extensions.”

d Click “Copy to file name.”

e Specify a drive letter and file name, for example, 
A:\Extensio.rpt.

f Insert a blank disk in drive A.

g Click “Start.”

h Remove the disk and set it aside for later use.

Next section

TURNKEY SYSTEM

All configurations Installing or reseating voice and fax boards, 
page 33

COMPONENT SYSTEM

All configurations Installing or reseating voice and fax boards, 
page 33
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Installing or 
reseating voice 
and fax boards

Do this section if you are installing a new Unity system. For 
information on adding or changing voice or fax boards, see 
“Upgrading a Unity or ActiveFax server,” on page 100. 

DO THIS SECTION?

TURNKEY 
SYSTEM

YES NO
see

page

All configurations ✓

COMPONENT 
SYSTEM

All configurations ✓

ACTIVEFAX SERVER

✓

Voice boards supported in Unity

Board Bus

Dialogic D/41D™, version 3 or later ISA

Dialogic D/41EPCI™ PCI

Dialogic D/41ESC™, version 3 or later ISA

Dialogic D/41ESC-Euro ISA

Dialogic D/120JCT-LS PCI

Dialogic D/160SC ISA

Dialogic D/160SC-LS™, version 2 or later ISA

Dialogic D/240PCI -T1™ PCI

Natural MicroSystems AG 2000 PCI

NMS AG Dual T1 PCI

NMS AG-T1 ISA

Fax boards supported in Unity

Board Bus

Dialogic GammaLink® CP4/LSI™, series 1 ISA

Dialogic GammaLink CP4/LSI, series 2 ISA

Dialogic GammaLink CPD/220™ ISA

Dialogic GammaLink CPi/200™ ISA

Dialogic GammaLink CPi/200 PCI™ PCI

Dialogic GammaLink CPi/400 PCI™ PCI

Natural MicroSystems AG 2000 PCI

Feature-set boards supported in Unity

Board Bus

Voice Technologies Group VoiceBridge 2000 for Mitel ISA
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Installing or 
reseating voice and 

Continued

fax boards

Reseating voice and fax boards in a turnkey 
system
During shipping, voice and fax boards in a turnkey system may 
become partially unseated. If you do not reseat the boards before 
you turn on the Unity server, you may encounter a variety of 
problems that are difficult to trace.

To reseat voice and fax boards

a If the Unity server is not already plugged into an outlet, plug 
it in now to provide a signal path to earth ground.

b If you already turned on the Unity server, shut down Unity 
and then shut down the Unity server. For more information, 
see “Shutting down and starting Unity,” on page 164.

c Remove the cover from the Unity server or expansion chas-
sis. 

d Attach an antistatic wrist strap. 

WARNING! Always use an antistatic wrist strap when you 
handle boards or other components. Static electricity can 
damage the components in computer equipment.

e For each voice and fax board, remove the screw that affixes 
the board to the box.

f Remove each board, and gently but firmly reseat it in its 
slot.

g Fasten each board to the computer’s backplate with a screw.
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Installing voice or fax boards

To find and reserve memory addresses and an IRQ 
(ISA boards in a component system only)

When you install ISA boards in a component system, you must 
reserve memory addresses and an IRQ so they are not taken by 
other boards.

a Run the resource utility that comes with the server to 
reserve resources for a legacy ISA board, including:

◆ 32 KB of memory in the D0000 range (D0000 to 
DFFFF).

◆ IRQ 5.

If IRQ 5 is already in use by a PCI board (a network interface 
card, for example), you can force the system to reserve 
IRQ 5, which will cause the PCI board to use another IRQ.

If you are using Dialogic D/160SC voice boards and Voice 
Technologies Group VoiceBridge 2000 feature-set boards, 
reserve two IRQs, one for the voice boards and one for the 
feature-set boards. See “Voice board worksheet,” on page 68 
for a list of valid IRQs.

If memory addresses in the D0000 range or IRQ 5 are not 
available, call Technical Support.

b Write down the memory addresses you reserved. You will 
need to specify those values during the Unity Setup pro-
gram.

To install voice or fax boards

a If the Unity or ActiveFax server is not already plugged into 
an outlet, plug it in now to provide a signal path to earth 
ground.

b If you already turned on the server, shut down the software 
and then shut down the server. For more information, see 
“Shutting down and starting Unity,” on page 164.

c Remove the cover from the server or expansion chassis. 

Continued
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Installing or 
reseating voice and 

Continued

fax boards

d Attach an antistatic wrist strap.

WARNING! Always use an antistatic wrist strap when you 
handle boards or other components. Static electricity can 
damage the components in computer equipment.

e Set the switches and jumpers on each board. Refer to “Hard-
ware settings” for your voice or fax board in Appendix A.

Some boards include hardware settings that indicate which 
board is first, which is second, and so on. If you are install-
ing more than one board of the same model, keep the 
boards in order so you can install them in the correct order 
in step h.

NOTE: Do not do the procedures under “Software setup” for 
your voice board in Appendix A at this time. The Unity Instal-
lation Guide alerts you when to do the procedures later in the 
installation.

f For VoiceBridge 2000 boards, record the serial number of 
each VoiceBridge 2000 board and its position relative to the 
D/160SC board on the “Voice board worksheet,” on 
page 68. The serial number is located on a label at the rear 
of the board. Keep the boards in the order in which you 
write them down on the worksheet.

g Select a slot for each board. For more information, see 
“Where to install voice and fax boards in a turnkey system,” 
on page 38. 

NOTES: PCI boards can be put into either 32-bit or 64-bit PCI 
slots. 

All ISA boards and all boards with SC or CT bus connectors 
must be installed in the same box. If not all boards fit in the 
Unity or ActiveFax server, then you must install all of them in 
an expansion chassis.

h Insert each board firmly into its slot, and fasten each board 
to the computer’s backplate with a screw.

If you are installing more than one board of the same model, 
and if the boards include a hardware setting that indicates 
which board is first, second, and so on, install the boards in 
the order specified by the hardware settings.

If you are installing D/160SC and VoiceBridge 2000 boards, 
install boards in the order in which they appear on the 
“Voice board worksheet,” on page 68.
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i If you are installing multiple voice boards that have SC or 
CT bus connectors, cable the boards together. On each 
board, connect the cable so the red stripe on the cable cor-
responds with pin 1 on the board connector. Confirm that 
the connectors are firmly seated.

If the cable has more connectors than the server has voice 
boards, use the first and last connectors, and leave unused 
connectors in the middle of the cable. If the end of a cable is 
allowed to dangle loose, it can act as a radio antenna and 
pick up noise from the bus.

If you are cabling three or more boards together, connect 
the first connector on the cable to the first board, the sec-
ond connector to the second board, and so on.

j Replace the cover of the server or expansion chassis.

Continued
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Installing or 
reseating voice and 

Continued

fax boards

Where to install voice and fax boards in a 
turnkey system

ISA slots

32-bit PCI slots

Dell 2300 Unity server 
This is a view of the right side with the cover removed. Begin installing 
voice boards at the bottom slot and work toward the top slot.

32-bit PCI slot

Full-length
64-bit PCI slots

ISA slot

Dell 2400 Unity server 
This is a view of the right side with the cover removed. Begin installing 
voice boards at the bottom slot and work toward the top slot.

ISA slots

32-bit PCI slots

Dell G1/GX200 Unity server
This is a top view of the slide-out expansion-board tray. Begin installing 
voice boards at the outside slot (closest to the tray-release lever) and 
work toward the inside slot.
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Next section

TURNKEY SYSTEM

All configurations Setting up the Unity or ActiveFax server, 
page 40

COMPONENT SYSTEM

All configurations Setting up the Unity or ActiveFax server, 
page 40

ACTIVEFAX SERVER

Setting up the Unity or ActiveFax server, 
page 40
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Setting up the 
Unity or 
ActiveFax 
server

In this section, you attach the system key, an expansion chassis 
(if necessary), and other peripherals, then connect the phone 
system and start the Unity or ActiveFax server.

We recommend that you connect the server to a dedicated 
uninterruptible power supply. Contact the dealer for more 
information.

A turnkey Unity server is configured for a specific hardware 
setup. Do not add or change any hardware on the Unity server, 
except to add memory, or voice or fax boards.

System key
The system key is programmed with the options and the number 
of ports purchased for the system. Unity checks the system key 
to activate the correct options; Unity does not start without the 
key. The same is true of ActiveFax when it is installed on a sepa-
rate server.

Expansion chassis
Systems with a large number of ports may use an expansion 
chassis to provide an adequate number of ISA or PCI slots. A 
50-pin cable—connected to I/O bus extender boards in the Unity 
server and the expansion chassis—connects the Unity server 
and the chassis.

DO THIS SECTION?

TURNKEY 
SYSTEM

YES NO
see

page

All configurations ✓

COMPONENT 
SYSTEM

All configurations ✓

ACTIVEFAX SERVER

✓
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Phone system
You connect the phone system during the procedure “To set up 
the Unity or ActiveFax server,” on page 42. See “Hardware set-
tings” for your voice or fax board in Appendix A for information 
about pinouts on boards in the Unity server. Refer to the follow-
ing list for connection information for an integration type or a 
specific phone system: 

Analog integrations  Connect the voice messaging lines to the 
voice boards in the Unity server.

Serial integrations  Connect the voice messaging lines to the 
voice boards in the Unity server, and connect the serial cable to 
the COM1 serial port on the Unity server. The Unity Integration 
Guide provides information about connecting Fujitsu 9600, 
Toshiba DK280/424, NEC NEAX 2400, Mitel, and Centrex 
phone systems to the Unity server. (Adapters for connecting the 
serial cable are provided.)

Norstar VMI  See the Norstar Voice Mail Interface Installation 
Guide for connection instructions.

Nortel/Calista and Lucent/Calista  See the Unity Integration 
Guide for connection instructions.

VoiceBridge 2000  Connect the voice messaging lines to the 
VoiceBridge 2000 feature-set boards in the Unity server.

To route fax messages directly to users’ e-mail Inboxes, the 
phone lines that will be used for faxes must be DID lines or ana-
log lines, and must send the fax ID of the recipient. In addition, 
the lines must be connected directly to the fax boards, either on 
the Unity server or on the ActiveFax server.

CAUTION: You cannot use a serial integration for fax lines.

Continued
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Setting up the Unity 

Continued

or ActiveFax server
To set up the Unity or ActiveFax server

a Place the server near the phone system and a network con-
nection, in a dry, cool area that is free of dust. Ideally, the 
server should be in the same room as any other Exchange 
servers with which it will be networked.

b Attach peripheral devices and the network cable, if appro-
priate, to the server.

c Attach the “Voice server” system key to the Unity server. If 
you are setting up a separate ActiveFax server, attach the 
“Fax server” system key. If you are connecting a printer to 
either server, plug it into the parallel port on the key.

d Connect the phone system to the server. (See the list on 
page 41 under “Phone system” for connection information 
for an integration type or a specific phone system, and for 
faxes.) 

CAUTION: If Natural MicroSystems AG-T1 or AG Dual T1 
voice boards are installed in the Unity server, confirm that the 
T1 lines from the phone system are functioning and plugged 
into the voice boards before you start the Unity server. Other-
wise, Unity may not start.
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Next section

TURNKEY SYSTEM

Voice mail only Starting the Unity server and logging on to 
Windows NT/2000, page 44

Voice mail with LAN admin Starting the Unity server and logging on to 
Windows NT/2000, page 44

Unified, one Exchange server

Unity server is a PDC Starting the Unity server and logging on to 
Windows NT/2000, page 44

Unity server is a member server Installing Windows NT Server, page 49

Unified, existing Exchange site Installing Windows NT Server, page 49

COMPONENT SYSTEM

All configurations Installing Windows NT Server, page 49

ACTIVEFAX SERVER

Installing Windows NT Server, page 49
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Starting the 
Unity server 
and logging on 
to Windows 
NT/2000

To start the Unity server and log on to 
Windows NT/2000

a Turn on the Unity server.

b When you see the Begin Logon dialog box, press 
CTRL+ALT+DELETE.

c In the Logon Information dialog box, type Administrator in 
the “User name” box.

d Type the password in the “Password” box. The default pass-
word on a Unity turnkey system is 12345.

e Confirm that the domain is Unity.

f Click “OK.”

Next section

DO THIS SECTION?

TURNKEY 
SYSTEM

YES NO
see

page

Voice mail only ✓
Voice mail with LAN admin ✓
Unified, one Exchange server

Unity server is a PDC ✓
Unity server is a member 

server
49

Unified, existing Exchange site 49

COMPONENT 
SYSTEM

Voice mail only 49

Voice mail with LAN admin 49

Unified, one Exchange server 49

Unified, existing Exchange site 49

ACTIVEFAX SERVER

49

TURNKEY SYSTEM

Voice mail only Changing passwords, page 45

Voice mail with LAN admin Changing passwords, page 45

Unified, one Exchange server

Unity server is a PDC Changing passwords, page 45
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Changing 
passwords

The default Windows NT/2000 account name and password for 
a Unity turnkey system (Administrator and 12345) appear in the 
documentation. To prevent unauthorized users from logging on 
and changing Unity settings, change the password on this 
account and on Exchange, Unity, and ActiveFax services.

To change passwords on the Administrator account 
and services

a Log on to Windows NT/2000 as Administrator.

b Change the password on the Windows NT/2000 
Administrator account.

c Change the password on all Exchange services.

d Change the password on all Unity services:

◆ AvCsGateway

◆ AvCsMgr

◆ AvGaenSvr

◆ AvMalSvr

e If the Unity server includes ActiveFax, change the password 
on the following ActiveFax services:

◆ LFAvLic

◆ LFExGateway

◆ LFusync

f Shut down and restart the Unity server. For more informa-
tion, see “Shutting down and starting Unity,” on page 164.

Continued

DO THIS SECTION?

TURNKEY 
SYSTEM

YES NO
see

page

Voice mail only ✓
Voice mail with LAN admin ✓
Unified, one Exchange server

Unity server is a PDC ✓
Unity server is a member 

server
49

Unified, existing Exchange site 49

COMPONENT 
SYSTEM

Voice mail only 49

Voice mail with LAN admin 49

Unified, one Exchange server 49

Unified, existing Exchange site 49

ACTIVEFAX SERVER

49
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Continued

Changing passwords Next section

TURNKEY SYSTEM

Voice mail only Creating an Outlook user profile, page 80

Voice mail with LAN admin

DHCP server on the network Confirming that the Unity or ActiveFax server 
is getting an IP address, page 54

No DHCP server Assigning a static IP address, page 47

Unified, one Exchange server

Unity server is a PDC, DHCP 
server on the network

Confirming that the Unity or ActiveFax server 
is getting an IP address, page 54

Unity server is a PDC, no DHCP 
server

Assigning a static IP address, page 47
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Assigning 
a static 
IP address

The Unity server must have an IP address to allow network 
administration of Unity and to allow subscriber access to the 
Unity ActiveAssistant. So, you must either connect the Unity 
server to a network that has a Dynamic Host Configuration Pro-
tocol (DHCP) server or assign a static IP address to the Unity 
server. (The Unity server is configured to automatically obtain an 
IP address from the DHCP server once the Unity server is physi-
cally connected to the network. However, you may prefer to man-
ually assign a static IP address.)

If the network does not have a DHCP server or you prefer to 
assign a static IP address, do the following procedure.

To assign a static IP address in Windows NT

a On the Windows Start menu, click Settings > Control Panel.

b Double-click the Network icon.

c Click the Protocols tab.

d If TCP/IP is installed, click “TCP/IP protocol” in the list and 
click “Properties.”

If TCP/IP is not installed, click “Add” to create a new proto-
col and click “TCP/IP protocol” in the list, then click “OK.”

e Specify the IP address, subnet mask, and default gateway.

f Click “OK.”

g Make any other changes in the dialog box, then click “OK.” 

h Restart the Unity server. For more information see “Shutting 
down and starting Unity,” on page 164.

To assign a static IP address in Windows 2000

a On the Windows Start menu, click Settings > Control Panel.

b Double-click the Network and Dial-up Connections icon.

c Double-click the Local Area Connection icon.

d Click “Properties.”

Continued

DO THIS SECTION?

TURNKEY 
SYSTEM

YES NO
see

page

Voice mail only 80

Voice mail with LAN admin

DHCP server on the network 54

No DHCP server ✓
Unified, one Exchange server

Unity server is a PDC, DHCP 
server on the network

54

Unity server is a PDC, no 
DHCP server ✓

Unity server is a member 
server

49

Unified, existing Exchange site 49

COMPONENT 
SYSTEM

Voice mail only 49

Voice mail with LAN admin 49

Unified, one Exchange server 49

Unified, existing Exchange site 49

ACTIVEFAX SERVER

49
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Assigning a static 

Continued

IP address
e  If TCP/IP is installed, click “TCP/IP protocol” in the list and 

click “Properties.”

If TCP/IP is not installed, add it, click it in the list, and click 
“Properties.”

f Specify the IP address, subnet mask, and default gateway.

g Click “OK.”

h Restart the Unity server. For more information, see “Shut-
ting down and starting Unity,” on page 164.

Next section

TURNKEY SYSTEM

Voice mail with LAN admin Confirming that the Unity or ActiveFax server 
is getting an IP address, page 54

Unified, one Exchange server

Unity server is a PDC Confirming that the Unity or ActiveFax server 
is getting an IP address, page 54
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Installing 
Windows NT 
Server

The following procedures describe how to install Windows NT 
version 4.0 by using the disks that are currently shipping with 
Unity. If you are using different disks or are installing Windows 
2000, the installation process may differ.

NOTE: If you are setting up a separate ActiveFax server, you can 
install Windows NT Workstation instead of Windows NT Server.

For more detailed information on individual steps in the installa-
tion process, see the Windows NT/2000 documentation that is 
included with the software.

To install Windows NT Server 4.0

a Insert Microsoft Windows NT Server Setup Disk 1 in drive A.

b Start the server.

c Follow the on-screen instructions until you are prompted to 
specify the partition on which to install Windows NT.

d If you are reinstalling Windows NT on the same partition 
where Windows NT is already installed, select and delete 
that partition, then continue with step e.

Otherwise, skip to step e.

e Select the partition on which to install Windows NT and 
press ENTER.

f If you chose to delete a partition in step d, select “Format 
the partition using the NTFS file system” and press ENTER, 
then continue with step g.

Otherwise, skip to step g.

g Follow the on-screen prompts until you are prompted to 
select a licensing mode.

h Click “Per seat” for the licensing mode, then click “Next” to 
continue.

Continued

DO THIS SECTION?

TURNKEY 
SYSTEM

YES NO
see

page

Voice mail only 80

Voice mail with LAN admin 54

Unified, one Exchange server

Unity server is a PDC 54

Unity server is a member 
server ✓

Unified, existing Exchange site ✓

COMPONENT 
SYSTEM

All configurations ✓

ACTIVEFAX SERVER

✓
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Installing Windows 

Continued

NT Server
i Follow the on-screen prompts until prompted to select a 

server type: 

PDC For the Unity server, click if the server will be a 
stand-alone voice messaging server or if you want to create 
a new domain. For the ActiveFax server, click if you want to 
create a new domain.

Backup domain controller Do not set up the Unity or 
ActiveFax server as a backup domain controller. This config-
uration is not supported.

Stand-alone (member) server Click if the Unity or Active-
Fax server will be a member server in an existing domain.

j Follow the on-screen prompts until you are prompted to 
install Microsoft Internet Information Server.

k Clear the “Install Microsoft Internet Information Server” 
check box, then click “Next” to continue.

l Follow the on-screen prompts to complete the installation.

To install Windows NT Service Pack 3

a Log on to Windows NT.

b Insert the Microsoft Windows NT Server Option Pack com-
pact disc in the CD-ROM drive.

c Browse to the directory WinntSP3\i386.

d Run Nt4sp3_i.exe.

e Follow the on-screen prompts until you are prompted to cre-
ate an uninstall directory.

f Click the “No, I do not want to create an uninstall directory” 
check box. 

g Follow the on-screen prompts until a dialog box appears 
explaining that 128-bit security will be replaced with 40-bit 
security.

h Click “Replace.” Another dialog box appears, also discussing 
128-bit and 40-bit security.

i Click “Replace.”

NOTE: 128-bit security will be restored when you install 
Windows NT Server Service Pack 6a.
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j Click “OK,” and Windows NT automatically restarts.

To install Internet Explorer 5.0

a Log on to Windows NT.

b Insert the Microsoft IE5 compact disc in the CD-ROM drive.

c Run Setup.exe.

d Click “Install Internet Explorer 5 and Internet Tools.” 

e Follow the on-screen prompts until you are prompted to 
select which components to install.

f Click “Install Now–Typical set of components,” then click 
“Next.”

g Follow the on-screen prompts.

To install Windows NT 4.0 Option Pack 4

a Log on to Windows NT.

b Insert the Microsoft Windows NT Server Option Pack com-
pact disc in the CD-ROM drive.

c Run Setup.exe in the root directory of the compact disc.

d Follow the on-screen prompts until you are prompted to 
select a type of install.

e Click “Minimum.” 

f Follow the on-screen prompts, and accept all default values.

Continued
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Installing Windows 

Continued

NT Server
Changing the Boot.ini file for serial 
integrations
If you are using a serial integration to connect the Unity or 
ActiveFax server and the phone system, do the following proce-
dure to ensure that Windows NT does not mistake the serial con-
nection for a serial mouse.

To change the Boot.ini file for serial integrations

a Make a backup copy of the Boot.ini file.

b Remove the hidden, system, and read-only attributes from 
the Boot.ini file.

c Using a text editor (for example, Notepad), open the Boot.ini 
file.

d Type /NoSerialMice at the end of each entry in the 
[operating systems] section of Boot.ini, for example:

[operating systems]
multi(0)disk(0)rdisk(0)partition(1)\WINNT="Windows NT Server Version 4.00" 
   /NoSerialMice
multi(0)disk(0)rdisk(0)partition(1)\WINNT="Windows NT Server Version 4.00 [VGA mode]"
   /basevideo /sos /NoSerialMice

e Save Boot.ini, and close the text editor.

f Restore the hidden, system, and read-only attributes to the 
Boot.ini file.

g Shut down and restart Windows NT.
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Next section

TURNKEY SYSTEM

Unified, one Exchange server Confirming that the Unity or ActiveFax server 
is getting an IP address, page 54

Unified, existing Exchange site Confirming that the Unity or ActiveFax server 
is getting an IP address, page 54

COMPONENT SYSTEM

Voice mail only Installing Exchange, page 60

Voice mail with LAN admin Confirming that the Unity or ActiveFax server 
is getting an IP address, page 54

Unified, one Exchange server Confirming that the Unity or ActiveFax server 
is getting an IP address, page 54

Unified, existing Exchange site Confirming that the Unity or ActiveFax server 
is getting an IP address, page 54

ACTIVEFAX SERVER

Confirming that the Unity or ActiveFax server 
is getting an IP address, page 54
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Confirming 
that the 
Unity or 
ActiveFax 
server is 
getting an 
IP address

After you have connected the Unity or ActiveFax server to a net-
work that has a DHCP server, or you have assigned a static 
address to the server, do the following procedure for the server to 
confirm that it has a valid IP address.

To confirm that the IP address is valid

a On the Windows NT Start menu, click Programs > 
Command Prompt.

Or on the Windows 2000 Start menu, click Programs > 
Accessories > Command Prompt. 

b In the Command Prompt window, type ipconfig and press 
ENTER.

c If the “IP address” value is:

Any value except “0.0.0.0”  The address is valid.

“0.0.0.0”  Either the Unity or ActiveFax server has a prob-
lem obtaining an address from the DHCP server or the 
assigned static IP address conflicts with the IP address of 
another computer on the network. Verify the network set-
tings. If needed, troubleshoot any problem as you would a 
network connectivity problem.

DO THIS SECTION?

TURNKEY 
SYSTEM

YES NO
see

page

Voice mail only 80

Voice mail with LAN admin ✓
Unified, one Exchange server ✓
Unified, existing Exchange site ✓

COMPONENT 
SYSTEM

Voice mail only 60

Voice mail with LAN admin ✓
Unified, one Exchange server ✓
Unified, existing Exchange site ✓

ACTIVEFAX SERVER

✓
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Next section

TURNKEY SYSTEM

Voice mail with LAN admin Setting up fax ports for ActiveFax, page 75
or, if no ActiveFax,
Creating an Outlook user profile, page 80

Unified, one Exchange server

Unity server is a PDC Setting up fax ports for ActiveFax, page 75
or, if no ActiveFax,
Creating an Outlook user profile, page 80

Unity server is a member server Installing Exchange, page 60

Unified, existing Exchange site

Unity server is a PDC Establishing trust relationships, page 56

Unity server is a member server Adding account permissions, page 58

COMPONENT SYSTEM

Voice mail with LAN admin Installing Exchange, page 60

Unified, one Exchange server Installing Exchange, page 60

Unified, existing Exchange site

Unity server is a PDC Establishing trust relationships, page 56

Unity server is a member server Adding account permissions, page 58

ACTIVEFAX SERVER

Unity server and ActiveFax server are 
in different domains

Establishing trust relationships, page 56

Unity server and ActiveFax server are 
in the same domain

Installing other software, page 64
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Establishing 
trust 
relationships

When you install Unity as a PDC (Windows NT) or domain con-
troller (Windows 2000) on a network that has other Exchange 
servers, you must establish a trust relationship with any domain 
that contains an Exchange server. You must establish trusts 
before installing Exchange.

The trusts allow Unity to:

◆ Set up subscriber accounts on other domains. (Because 
subscriber accounts normally do not use the Unity server as 
a home server, all subscriber accounts will be on another 
domain if the Unity server is a PDC or domain controller.) 

◆ Accept authentications of subscribers who are logged on to 
other domains. 

The network administrator will know which trusts are necessary 
and may prefer to set them up.

To add trusts on the Unity server

While doing this procedure, you may receive an error message 
indicating that a trust cannot be verified. This message normally 
appears because you have not yet set up the trust on the other 
server. The message usually can be ignored.

a Log on to the Unity server as the domain administrator.

b On the Windows NT Start menu, click Programs > Adminis-
trative Tools (Common) > User Manager for Domains.

Or on the Windows 2000 Start menu, click Administrative 
Tools > Active Directory Domains and Trusts.

c Add each domain that contains an Exchange server as a 
trusting domain. (For more information, see the Windows 
“User Manager for Domains” or “Active Directory” Help.)

NOTE: Set up trusting domains before you set up trusted 
domains. Otherwise, you may need to wait up to 15 minutes 
for the trusts to establish (or you could restart the Unity 
server instead).

d Add each domain that contains an Exchange server as a 
trusted domain.

DO THIS SECTION?

TURNKEY 
SYSTEM

YES NO
see

page

Voice mail only 80

Voice mail with LAN admin 80

Unified, one Exchange server 80

Unified, existing Exchange site

Unity server is a PDC ✓
Unity server is a member 

server
58

COMPONENT 
SYSTEM

Voice mail only 60

Voice mail with LAN admin 60

Unified, one Exchange server 60

Unified, existing Exchange site

Unity server is a PDC ✓
Unity server is a member 

server
58

ACTIVEFAX SERVER

Unity server and ActiveFax 
server are in different 
domains

✓

Unity server and ActiveFax 
server are in the same 
domain

64
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To add trusts on other Exchange servers or on the 
ActiveFax server

While doing this procedure, you should not receive any error 
messages.

a On a server in a domain that contains an Exchange server 
or the ActiveFax server, log on as the administrator for that 
domain.

b On the Windows NT Start menu, click Programs > Adminis-
trative Tools (Common) > User Manager for Domains.

Or on the Windows 2000 Start menu, click Administrative 
Tools > Active Directory Domains and Trusts.

c Add the domain that contains the Unity server as a trusting 
domain. (For more information, see the Windows “User 
Manager for Domains” or “Active Directory” Help.)

NOTE: Set up trusting domains before you set up trusted 
domains. Otherwise, you may need to wait up to 15 minutes 
for the trusts to establish (or you could restart the Unity 
server instead).

d Add the domain that contains the Unity server as a trusted 
domain.

e Repeat steps steps a through d on all other domains that 
contain Exchange servers.

Next section

TURNKEY SYSTEM

Unified, existing Exchange site

Unity server is a PDC Adding account permissions, page 58

COMPONENT SYSTEM

Unified, existing Exchange site

Unity server is a PDC Adding account permissions, page 58

ACTIVEFAX SERVER

Installing other software, page 64
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Adding account 
permissions

Before you install Exchange in a site with other Exchange serv-
ers, you must grant Services Account Administration permis-
sions to the Windows NT/2000 domain administrator account.

To add account permissions

Do this procedure on an Exchange server other than the Unity 
server. Repeat it on the Unity server if you want to allow either 
server to administer the other.

a Log on to an Exchange server by using an Exchange Ser-
vices Account Administration account.

b On the Windows Start menu, click Programs > Microsoft 
Exchange > Microsoft Exchange Administrator.

c In the tree, click the organization name.

d On the File menu, click “Properties.”

e Click the Permissions tab.

f Click “Add.”

g Under “List names from,” click the Unity server’s domain. 
(On turnkey systems, the domain name is Unity unless you 
changed it.) If the domain is not listed, the proper trusts 
have not been established.

h In the list of names, select the Windows NT/2000 domain 
administrator account.

i Click “Add.”

j Click “OK” to close the Add Users and Groups dialog box.

k Under “Roles,” click “Service account admin.”

l Click “OK” to close the Properties dialog box.

m Repeat steps c through l for the site and the configuration 
container, which also appear in the tree.

DO THIS SECTION?

TURNKEY 
SYSTEM

YES NO
see

page

Voice mail only 80

Voice mail with LAN admin 80

Unified, one Exchange server

Unity server is a PDC 80

Unity server is a member 
server

60

Unified, existing Exchange site ✓

COMPONENT 
SYSTEM

Voice mail only 60

Voice mail with LAN admin 60

Unified, one Exchange server

Unity server is a PDC 60

Unity server is a member 
server

60

Unified, existing Exchange site ✓

ACTIVEFAX SERVER

64
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Next section

TURNKEY SYSTEM

Unified, existing Exchange site Installing Exchange, page 60

COMPONENT SYSTEM

Unified, existing Exchange site Installing Exchange, page 60
CHAPTER 3: Installing a Unity system 59



Installing 
Exchange

During installation, you are asked to choose between joining an 
existing Exchange site or creating a new site:

Join a site  When there is an existing Exchange site and you 
want to add the Unity server to that site, join the existing site.

Create a site  When the Unity server is the only Exchange server 
or when there are other Exchange servers but you want the 
Unity server to be a stand-alone voice messaging system, create 
a new site.

To install Exchange

This procedure applies only to the Exchange discs shipped with 
Unity. If you are using different discs (for example, Backoffice 
Server), the procedure may differ.

a Log on to Windows NT/2000 by using the domain adminis-
trator account.

b Insert Microsoft Exchange version 5.5 Disc 1 in the 
CD-ROM drive.

c If the “Microsoft Exchange Server” screen does not appear 
automatically, run Launch.exe in the root directory of the 
compact disc.

d Click “Setup server and components.”

e Click “Microsoft Exchange Server 5.5.”

f Accept the license agreement.

g Click “Complete/Custom.”

h Clear the “Outlook Web Access” check box.

Optionally, you can save disk space by choosing not to 
install the MS Mail and/or cc:Mail connectors if the site 
does not require them. In the list, select “Microsoft 
Exchange Server,” then click “Change option.” Clear the 
“MS Mail Connector” or “cc:Mail Connector” check box, as 
appropriate. Then click “OK.”

i Click “Continue.”

j Follow the on-screen prompts until you are prompted to run 
the optimizer.

k Click “Run optimizer.”

l Follow the on-screen prompts.

DO THIS SECTION?

TURNKEY 
SYSTEM

YES NO
see

page

Voice mail only 80

Voice mail with LAN admin 80

Unified, one Exchange server

Unity server is a PDC 80

Unity server is a member 
server ✓

Unified, existing Exchange site ✓

COMPONENT 
SYSTEM

All configurations ✓

ACTIVEFAX SERVER
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m At the “Microsoft Exchange Server” screen, click “Exit.”

n Shut down and restart the server.

To install Exchange Service Pack 3

a Log on to Windows NT/2000 by using the domain adminis-
trator account.

b Insert Microsoft Exchange version 5.5 Disc 2 in the 
CD-ROM drive.

c Browse to the directory Eng\Server\Setup\I386.

d Run Update.exe.

e Follow the on-screen prompts.

f Shut down and restart the server.

To configure Exchange

a On the Start menu, click Programs > Microsoft Exchange > 
Microsoft Exchange Administrator.

b In the dialog box that appears, click “Browse.”

c In the Server Browser dialog box, click the name of the Unity 
server (Unity-PDC1 is the default value on a turnkey sys-
tem), then click “OK.”

d In the Connect to Server dialog box, click “Set as default,” 
then click “OK.”

Continued
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Continued

Installing Exchange To install Outlook

You install Outlook because anyone calling Technical Support 
may be asked to use Outlook to perform troubleshooting.

a Insert the compact disc that contains Outlook in the 
CD-ROM drive.

b Run Setup.exe.

c Follow the on-screen prompts to complete the installation.

Next section

TURNKEY SYSTEM

Unified, one Exchange server

Unity server is a member server Installing Microsoft Data Access 
Components, page 63

Unified, existing Exchange site Installing Microsoft Data Access 
Components, page 63

COMPONENT SYSTEM

All configurations Installing Microsoft Data Access 
Components, page 63
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Installing 
Microsoft Data 
Access 
Components

Microsoft Data Access Components (MDAC) version 2.5 or later 
must be installed before you install Unity. If you installed 
Windows 2000 on the Unity server, you can skip this procedure 
because the correct version of MDAC was installed automati-
cally.

To install MDAC

a Insert the Unity compact disc in the CD-ROM drive.

b Browse to the directory Mdac.

c Run Mdac_typ.exe.

Next section

DO THIS SECTION?

TURNKEY 
SYSTEM

YES NO
see

page

Voice mail only 80

Voice mail with LAN admin 80

Unified, one Exchange server

Unity server is a PDC 80

Unity server is a member 
server ✓

Unified, existing Exchange site ✓

COMPONENT 
SYSTEM

All configurations ✓

ACTIVEFAX SERVER

64

TURNKEY SYSTEM

Unified, one Exchange server

Unity server is a member server Installing other software, page 64

Unified, existing Exchange site Installing other software, page 64

COMPONENT SYSTEM

All configurations Installing other software, page 64
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Installing other 
software

Follow the instructions that come with each software package to 
install Symantec pcAnywhere and Symantec Norton Utilities 
(install only Speed Disk and Norton Disk Doctor).

The Unity documentation is available on the Unity compact disc 
in Adobe® Acrobat® (PDF) format. To view the Acrobat files on the 
Unity or ActiveFax server, you need to install Acrobat Reader, 
which is also available on the Unity compact disc.

To install Acrobat Reader on the Unity server

a Insert the Unity compact disc in the CD-ROM drive.

b Browse to the appropriate directory, 
Documentation\Acrobat reader installation\Win16 or 
Win32, and run the executable file in that directory.

c Follow the on-screen prompts.

Next section

DO THIS SECTION?

TURNKEY 
SYSTEM

YES NO
see

page

Voice mail only 80

Voice mail with LAN admin 80

Unified, one Exchange server

Unity server is a PDC 80

Unity server is a member 
server ✓

Unified, existing Exchange site ✓

COMPONENT 
SYSTEM

All configurations ✓

ACTIVEFAX SERVER

✓

TURNKEY SYSTEM

Unified, one Exchange server

Unity server is a member server Installing Windows NT Service Pack 6a, 
page 65

Unified, existing Exchange site Installing Windows NT Service Pack 6a, 
page 65

COMPONENT SYSTEM

All configurations  Installing Windows NT Service Pack 6a, 
page 65

ACTIVEFAX SERVER

Installing Windows NT Service Pack 6a, 
page 65
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Installing 
Windows NT 
Service Pack 6a

To install Windows NT Service Pack 6a

a Log on to Windows NT.

b Insert the Microsoft Windows NT Service Pack 6a compact 
disc in the CD-ROM drive.

c Run Sp6i386 128 bit.exe.

d When you are prompted to accept the license agreement, 
select the “Accept the license agreement” check box, and 
clear the “Backup files necessary to uninstall this Service 
Pack at a later time” check box.

e Click “Install.”

f Shut down and restart the server.

Continued

DO THIS SECTION?

TURNKEY 
SYSTEM

YES NO
see

page

Voice mail only 80

Voice mail with LAN admin 80

Unified, one Exchange server

Unity server is a PDC 80

Unity server is a member 
server ✓

Unified, existing Exchange site ✓

COMPONENT 
SYSTEM

All configurations ✓

ACTIVEFAX SERVER

✓
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Installing 
Windows NT Service 

Continued

Pack 6a

Next section

TURNKEY SYSTEM

Unified, one Exchange server

Unity server is a member server Installing Unity and ActiveFax, page 69

Unified, existing Exchange site Installing Unity and ActiveFax, page 69

COMPONENT SYSTEM

All configurations  Finding I/O addresses for VoiceBridge 2000 
feature-set boards, page 67 

ACTIVEFAX SERVER

Installing Unity and ActiveFax, page 69
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Finding I/O 
addresses for 
VoiceBridge 
2000 
feature-set 
boards

If you are installing a component system and using Dialogic 
D/160SC voice boards and Voice Technology Group VoiceBridge 
2000 feature-set boards, you must find and record available I/O 
addresses for the VoiceBridge 2000 boards. During the Unity 
Setup program, you will be prompted to enter these values. 

To find available I/O addresses

a Start the Unity server.

b On the Windows NT Start menu, click Programs > Adminis-
trative Tools (Common) > Windows Diagnostics.

Or on the Windows 2000 Start menu, click Programs > 
Accessories > System Tools > System Information.

c In Windows NT, click the Resources tab.

Or in Windows 2000, expand Hardware Resources.

d In Windows NT, click “I/O Port.” 

Or in Windows 2000, click “I/O.” 

e In the list of assigned I/O addresses, find an available range 
of four consecutive I/O addresses for each VoiceBridge 2000 
board (for example, 0224 to 0227). The VoiceBridge 2000 
board supports several I/O addresses, including 0224-0240 
and 0280-02A0.

CAUTION: Do not use I/O addresses 0270-0273. These I/O 
addresses are used by the VoiceBridge 2000 software to ini-
tially configure the VoiceBridge 2000 boards.

f Record the base address for each VoiceBridge 2000 board on 
the “Voice board worksheet,” on page 68.

NOTE: The base address is the first I/O address in the avail-
able range. For example, if two VoiceBridge 2000 boards are 
installed and I/O addresses 0224–022B are available, the 
base address for the first board is 0224 and the base 
address for the second board is 0228. On Unity turnkey sys-
tems, the base addresses have been set to 220, 224, 228, 
22C, 230, and 234.

Continued

DO THIS SECTION?

TURNKEY 
SYSTEM

YES NO
see

page

Voice mail only 80

Voice mail with LAN admin 75

Unified, one Exchange server 75

Unified, existing Exchange site 75

COMPONENT 
SYSTEM

Voice mail only ✓
Voice mail with LAN admin ✓
Unified, one Exchange server ✓
Unified, existing Exchange site ✓

ACTIVEFAX SERVER

69
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Finding I/O 
addresses for 
VoiceBridge 2000 

Continued

feature-set boards

g In Windows NT, click “OK” to exit Windows Diagnostics.

Or in Windows 2000, close System Information. 

Next section

Voice board worksheet

Board Serial 
number

IRQ
(circle one)

Base
address

Master
setting

Rotary dial
setting

D/160SC N/A 2 3 4 5 6 7 10 11 12 14 15 N/A N/A 0

VoiceBridge 1 3 5 7 10 11 12 15 master N/A

VoiceBridge 2 Same as first VoiceBridge slave N/A

D/160SC N/A same as first D/160 N/A N/A 1

VoiceBridge 3 Same as first VoiceBridge slave N/A

VoiceBridge 4 Same as first VoiceBridge slave N/A

D/160SC N/A same as first D/160 N/A N/A 2

VoiceBridge 5 Same as first VoiceBridge slave N/A

VoiceBridge 6 Same as first VoiceBridge slave N/A

COMPONENT SYSTEM

All configurations Installing Unity and ActiveFax, page 69
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Installing Unity 
and ActiveFax

You run the Unity Setup program if:

◆ You are installing Unity and (optionally) ActiveFax on the 
Unity server, and either you are installing a component sys-
tem or you are reinstalling all software on a turnkey system.

◆ You are installing ActiveFax on a separate server. In this sit-
uation, you install ActiveFax first.

The account used for installation on the Unity 
server
The Windows NT/2000 account that you log on with to install 
Unity and ActiveFax on the Unity server has a significant impact 
on the installed Unity system, so choose this account carefully.

This account is the owner of the Windows NT/2000 services for 
Unity and ActiveFax. Changing the owner or the password for 
each of these services is time consuming, so you probably want 
to choose an account that you do not intend to change regularly. 
You may even want to create an account whose sole purpose is 
to be the owner of the Unity and ActiveFax services.

The Unity Setup program creates a number of Windows 
NT/2000 and Exchange accounts and other objects, so the 
account you log on with must have enough security access to 
perform the necessary operations. This account must:

◆ Be a member of the Domain Admins group (typically this 
group is a member of the Local Administrators group for the 
domain). Domain Admin rights ensure that the Unity Setup 
program can create default users during installation. 

◆ Be a member of the Local Administrators group.

◆ Have the right to log on locally.

◆ Have the right to act as part of the operating system.

◆ Have the right to log on as a service.

◆ Have Exchange Services Account Administration permis-
sions for the site and the configuration container that Unity 
is being installed into.

Continued

DO THIS SECTION?

TURNKEY 
SYSTEM

YES NO
see

page

Voice mail only 80

Voice mail with LAN admin 80

Unified, one Exchange server

Unity server is a PDC 80

Unity server is a member 
server ✓

Unified, existing Exchange site ✓

COMPONENT 
SYSTEM

All configurations ✓

ACTIVEFAX SERVER

✓
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Installing Unity and 

Continued

ActiveFax
If you are installing ActiveFax, the account used for installation 
on the Unity server must be the account that Exchange on the 
Unity server starts with. By default, this is the account that 
Exchange was installed with.

Unity and ActiveFax installation

To uninstall any existing fax gateways

Other Exchange fax gateways conflict with ActiveFax. Before you 
install or upgrade ActiveFax, uninstall any existing fax gateways.

a Refer to your fax server documentation for instructions on 
uninstalling fax gateways.

b After you remove the gateways, allow time for their removal 
to be replicated throughout the site.

To confirm that the Windows NT/2000 date and time 
formats are correct

Before you install Unity and ActiveFax, confirm that the Win-
dows NT/2000 date and time formats are correct. If you change 
the formats after you install Unity and ActiveFax, fax reports will 
fail.

a On the Windows Start menu, click Settings > Control Panel.

b Double-click the Regional Settings icon.

c Confirm that the format settings on the Date and Time tabs 
are correct.

d Click “OK” to close the Regional Settings Properties dialog 
box.

To install ActiveFax on a separate server

Install ActiveFax first. When you install the Unity software on 
the Unity server, you are prompted to specify the name of the 
server on which ActiveFax is installed. The Unity Setup program 
then verifies that ActiveFax is running on that server.

a Confirm that the ActiveFax system key is connected to the 
ActiveFax server.
UNITY INSTALLATION GUIDE70



b Confirm that all fax boards have been installed and set up 
according to the “Hardware settings” instructions for your 
boards in Appendix A.

c Log on to Windows NT/2000 by using the account you chose 
to use for installation.

d Insert the Unity compact disc in the CD-ROM drive.

e Browse to the root directory of the Unity compact disc, and 
run Setup.exe.

f Choose the language in which you want to view Setup 
prompts, and click “OK.” A welcome message appears.

g Click “Next,” and Setup examines your system to confirm 
that the required software is installed and configured prop-
erly and that a system key is installed.

If an error message appears, correct the specified problem, 
then rerun Setup.

h Follow the on-screen prompts.

When you are prompted to select which features to install, 
select the “Install fax server” check box. (If the check box is 
not available, the system key does not include the option to 
install ActiveFax).

If the ActiveFax server contains NMS fax boards, also select 
the “Install voice board software” check box.

i Follow the on-screen prompts to complete the installation.

j Restart the ActiveFax server.

Continued
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Installing Unity and 

Continued

ActiveFax
To install Unity and ActiveFax on the Unity server

Do the following procedure to:

◆ Install Unity.

◆ Install ActiveFax on the Unity server or, if ActiveFax was 
installed on a separate server, install the Exchange gateway 
for ActiveFax on the Unity server.

Install ActiveFax on the Unity server only if you are configuring 
the Unity server as a stand-alone voice messaging server with 
LAN administration or as a unified messaging server in an exist-
ing Exchange site. Other configurations are not supported.

a Confirm that the Unity system key is connected to the Unity 
server.

b Confirm that all voice and fax boards have been installed 
and set up according to the “Hardware settings” instruc-
tions for your boards in Appendix A.

If you are installing a component system and the server 
contains Dialogic D/41D voice boards, note the setting of 
jumper JP1 (IRQ setting) because you must enter that value 
at the end of the Setup program.

c Start the Unity server.

d Log on to Windows NT/2000 by using the account you chose 
to use for installation.

e Insert Unity Disc 1 in the CD-ROM drive.

f Browse to the root directory of the Unity compact disc, and 
run Setup.exe.

g Choose the language in which you want to view Setup 
prompts, and click “OK.” A welcome message appears.

h Click “Next,” and Setup examines your system to confirm 
that the required software is installed and configured prop-
erly, and that a system key is installed.

If an error message appears, correct the specified problem, 
then rerun Setup.

i Follow the on-screen prompts.
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j When you are prompted to select the features you want to 
install, select the “Install Unity” and “Install voice board 
software” check boxes. If you already installed ActiveFax on 
a separate server or if you want to install ActiveFax on the 
Unity server, also select the “Install fax server” check box. (If 
ActiveFax is installed on another server, you still need to 
install the Exchange fax gateway on the Unity server.)

If the “Install fax server” check box is not available, the sys-
tem key does not include the option to install ActiveFax on 
the Unity server.

k Follow the on-screen prompts to continue the installation.

l After the Unity software is installed and configured, you may 
be prompted to enter settings for the voice boards in the 
Unity server. If the server contains: 

Dialogic PCI boards only No settings are required, so no 
dialog box appears. Skip to step m.

Dialogic ISA boards only Do the “Software setup” procedure 
for your voice boards in Appendix A.

Dialogic D/160SC voice boards and VoiceBridge 2000 
feature-set boards Do the “Software setup” procedures for 
both boards in Appendix A, starting with the VoiceBridge 
2000 feature-set boards. 

Only one model of NMS boards Do the “Software setup” 
procedure for your voice boards in Appendix A.

Both NMS AG Dual T1 and AG-T1 boards Do the “Software 
setup” procedures for both boards in Appendix A, starting 
with the AG Dual T1.

m Follow the on-screen prompts to complete the installation.

n Restart the Unity server.

Continued
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Installing Unity and 

Continued

ActiveFax
Next section

TURNKEY SYSTEM

Unified, one Exchange server

Unity server is a member server Setting up fax ports for ActiveFax, page 75
or, if no ActiveFax,
Creating an Outlook user profile, page 80

Unified, existing Exchange site Setting up fax ports for ActiveFax, page 75
or, if no ActiveFax,
Creating an Outlook user profile, page 80

COMPONENT SYSTEM

Voice mail only Creating an Outlook user profile, page 80

Voice mail with LAN admin Setting up fax ports for ActiveFax, page 75
or, if no ActiveFax,
Creating an Outlook user profile, page 80

Unified, one Exchange server Setting up fax ports for ActiveFax, page 75
or, if no ActiveFax,
Creating an Outlook user profile, page 80

Unified, existing Exchange site Setting up fax ports for ActiveFax, page 75
or, if no ActiveFax,
Creating an Outlook user profile, page 80

ACTIVEFAX SERVER

Setting up fax ports for ActiveFax, page 75
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Setting up 
fax ports for 
ActiveFax

If you installed ActiveFax, run the FAX Monitor program to:

◆ Set whether a fax port sends faxes, receives faxes, or both 
sends and receives faxes.

◆ Enter settings for routing inbound faxes.

The FAX Monitor contains information about the fax ports on the 
server that ActiveFax is installed on; the information was auto-
matically detected during the ActiveFax installation. The infor-
mation is displayed in the FAX Monitor window, shown below, 
and in its Setup dialog box.

Each square at the bottom of the FAX Monitor window repre-
sents a fax port. Colored squares indicate fax ports that are 
available for use with ActiveFax. 

The number of fax ports available to ActiveFax is specified on the 
Unity system key (or on the ActiveFax system key if ActiveFax is 
on a separate server). If the number on the key is less than the 
total number of fax ports on the installed fax boards, ActiveFax 
disables the extra ports. A red “X” in a FAX Monitor square 
means that ActiveFax has disabled the corresponding fax port. 

Continued

DO THIS SECTION?

TURNKEY 
SYSTEM

YES NO
see

page

Voice mail only 80

Voice mail with LAN admin ✓
Unified, one Exchange server ✓
Unified, existing Exchange site ✓

COMPONENT 
SYSTEM

Voice mail only 80

Voice mail with LAN admin ✓
Unified, one Exchange server ✓
Unified, existing Exchange site ✓

ACTIVEFAX SERVER

✓
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Setting up fax ports 

Continued

for ActiveFax
To display the Setup dialog box
The Setup dialog box can be displayed only when the LFdriver, a 
component of ActiveFax, is not running. (The LFdriver provides 
the interface between the fax boards and ActiveFax.) The 
LFdriver starts automatically when the server that ActiveFax is 
installed on starts. When you want to display the Setup dialog 
box, you can stop the LFdriver from the FAX Monitor.

a On the ActiveFax server, click Start > Programs > 
ActiveFax > Monitor.

b If “Setup!” on the FAX Monitor menu bar is available, skip to 
step c.

If “Setup!” is unavailable, click “Stop” on the LFdriver menu. 
(Stopping the driver may take a few minutes.)

c On the menu bar, click “Setup!”

c

b
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To enter setup information

You enter information only on the Channel tab of the Setup 
dialog box and only for the settings listed in this procedure. 
ActiveFax automatically enters information on the other tabs.

a In the Setup dialog box, click the Channel tab.

b Select the fax port for which you are entering information.

c If ActiveFax has just been installed, skip to step d. (The 
Unity Setup program automatically detected information 
about the fax port. The “Board type” box displays the type of 
fax board in the Unity server.)

If you added or removed fax boards, or reconfigured a fax 
port, click “Auto detect.”

d Indicate whether the port sends faxes, receives faxes, or 
both sends and receives faxes.

e Select your country.

f Type the access code needed to make an external call (for 
example, 9), followed by a comma to insert a half-second 
pause before the fax phone number is dialed.

Continued

4

2 3

5
6
7
8
9

-

CHAPTER 3: Installing a Unity system 77



Setting up fax ports 

Continued

for ActiveFax
g Type the maximum number of digits that ActiveFax uses to 

identify the recipient. The value that you enter depends on 
the automatic routing method and on your organization’s 
phone system. This value is the number of digits used in the 
“Fax ID” box in subscriber accounts. ActiveFax determines 
the recipient by comparing the right-most digits of the 
inbound fax number to the right-most digits of the fax num-
ber stored in each subscriber’s Exchange mailbox, until it 
finds a match.

h Type the number of rings before the fax port answers a call.

i Select an automatic routing method for inbound faxes: DID, 
DTMF (telco), DTMF (manual), DNIS, or VPS.

j Repeat steps b through i for each port for which you are 
entering setup information.

k Click “OK.” The FAX Monitor window reappears.

To start the LFdriver

If Unity is running, you must start the LFdriver so that faxes can 
be sent and received.

In the FAX Monitor window, click “Start” on the LFdriver 
menu. (Starting the driver may take a few minutes.)
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Next section

TURNKEY SYSTEM

Voice mail with LAN admin “Creating an Outlook user profile,” on 
page 80

Unified, one Exchange server “Creating an Outlook user profile,” on 
page 80

Unified, existing Exchange site “Creating an Outlook user profile,” on 
page 80

COMPONENT SYSTEM

Voice mail with LAN admin “Creating an Outlook user profile,” on 
page 80

Unified, one Exchange server “Creating an Outlook user profile,” on 
page 80

Unified, existing Exchange site “Creating an Outlook user profile,” on 
page 80

ACTIVEFAX SERVER

“Creating an emergency repair disk,” on 
page 82
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Creating an 
Outlook 
user profile

To use Outlook for troubleshooting, you must create an Outlook 
user profile on the Unity server for at least one Unity subscriber.

To create an Outlook user profile

a On the Windows Start menu, click Settings > Control Panel.

b Double-click the Mail icon or the Mail and Fax icon.

c On the Services tab, click “Show profiles.”

d In the Mail and Fax dialog box, click “Add.”

e In the Microsoft Outlook Setup wizard, click “Microsoft 
Exchange Server” in the list, then click “Next.”

f Under “Profile name,” type the name of the domain adminis-
trator account (currently the only Unity subscriber on the 
system).

If this is a Unity turnkey system and you have not rein-
stalled Windows NT, type Administrator.

If this is a component system or if you reinstalled Windows 
NT on a turnkey system, type the name of the Windows NT 
administrator account that you used to install Unity.

g Click “Next.”

h Under “Microsoft Exchange Server,” type the name of the 
Unity server. (On a turnkey system, the server name is 
Unity-PDC1 unless you changed it.)

i Under “Mailbox,” again type the name of the domain admin-
istrator account, then click “Next.”

j Click “Next” to accept the remaining defaults in the wizard, 
then click “Finish.”

k In the Mail and Fax dialog box, click “Close.”

DO THIS SECTION?

TURNKEY 
SYSTEM

YES NO
see

page

All configurations ✓

COMPONENT 
SYSTEM

All configurations ✓

ACTIVEFAX SERVER

82
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Next section

TURNKEY SYSTEM

All configurations Creating an emergency repair disk, page 82

COMPONENT SYSTEM

All configurations Creating an emergency repair disk, page 82
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Creating an 
emergency 
repair disk

At this point in the installation, it is a good idea to create an 
emergency repair disk. This disk will store a record of the Win-
dows NT/2000 registry, which is a database of settings for the 
accounts, hardware, and applications. Label the repair disk and 
store it in a secure location.

Unity stores a lot of information in the Windows NT/2000 regis-
try; however, the registry record on the repair disk is not a sub-
stitute for a comprehensive strategy for backing up Unity. Unity 
stores messages and address information in Exchange, and 
stores information such as tone templates, phone system config-
uration information, and call routing rules in other locations. 
See the Unity System Administration Guide for more information 
on backup strategies.

NOTE: The emergency repair disk is not bootable.

To create an emergency repair disk (Windows NT)

a On the Windows NT Start menu, click Programs > 
Command Prompt.

b In the Command Prompt window, run the rdisk command.

(For more information, see the Windows NT/2000 Help on 
creating an emergency repair disk, and articles on the rdisk 
command in the knowledge base on the Microsoft Web site, 
http://www.microsoft.com.)

To create an emergency repair disk (Windows 2000)

a On the Windows 2000 Start menu, click Programs > 
Accessories > System Tools > Backup.

b Click “Emergency Repair Disk,” and follow the on-screen 
prompts.

DO THIS SECTION?

TURNKEY 
SYSTEM

YES NO
see

page

All configurations ✓

COMPONENT 
SYSTEM

All configurations ✓

ACTIVEFAX SERVER

✓
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Next section 

TURNKEY SYSTEM

All configurations Configuring Unity to work with the phone 
system, page 86

COMPONENT SYSTEM

All configurations Configuring Unity to work with the phone 
system, page 86

ACTIVEFAX SERVER

What’s next, page 113
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Configuring 
Unity to work 
with the phone 
system

In this section, you verify information about the phone system 
and enter settings for the ports.

To verify phone system information

a In the Unity Administrator, go to System > Switch. For more 
information, see “Using the Unity Administrator,” on 
page 168.

b Verify the manufacturer of the site’s phone system. If the 
manufacturer is not listed, select the manufacturer of a 
similar phone system. 

c Verify the model of the phone system. If the model is not 
listed, select a similar model.

DO THIS SECTION?

TURNKEY 
SYSTEM

YES NO
see

page

All configurations ✓

COMPONENT 
SYSTEM

All configurations ✓
f

b

d
e

g

c

h
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d Verify the version of the phone system software.

e Verify the integration type.

f If necessary, edit the codes that turn message waiting indi-
cation on and off.

g If necessary, edit the message waiting indicator resync time.

h Click the Save icon.

i Shut down and restart Unity for the phone system settings 
to take effect.

Continued
CHAPTER 4: Setting up the integration 87



Configuring Unity to 
work with the phone 

Continued

system

To enter port settings

You set whether ports answer incoming calls; dial out for mes-
sage waiting indication, message notification, or making record-
ings by phone; or are disabled.

If you are setting up a hunt group, use the first voice-messaging 
ports for incoming calls and the last ports to dial out. This helps 
minimize the possibility of a collision, in which an incoming call 
arrives on a port at the same time that Unity takes the port 
off-hook to dial out.

a In the Unity Administrator, go to System > Ports.

c

f

d

b
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b Select a port in the table.

c Indicate the settings for the port.

d Type the extension for the port.

CAUTION: If the extension for the port is not entered cor-
rectly, some integrations may not work.

e Repeat steps b through d for the remaining ports.

f Click the Save icon.

g Shut down and restart the Unity server. For more informa-
tion, see “Shutting down and starting Unity,” on page 164.

Next section

TURNKEY SYSTEM

All configurations “Programming the phone system,” on 
page 90

COMPONENT SYSTEM

All configurations “Programming the phone system,” on 
page 90

TIP

Use Help for descriptions of the

port settings. At the top of the

page, click the Help icon with the

question mark. Then click the

question mark link next to a set-

ting for information about that

setting.
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Programming 
the phone 
system

In this section, you program the phone system to work with 
Unity. The instructions that you use depend on whether a Unity 
Integration Guide came with Unity. The guide is provided for inte-
grations with the following phone systems: 

◆ Centrex/SMDI

◆ Cisco CallManager

◆ Fujitsu 9600/SMDI

◆ Lucent/Calista

◆ Mitel/Calista

◆ Mitel SX-2000 T1

◆ Mitel/Voice Technologies Group VoiceBridge 2000

◆ NEC NEAX® 2400 with LAN MCI

◆ NEC NEAX 2400 with serial MCI

◆ Norstar VMI

◆ Nortel/Calista

◆ Toshiba DK280/424 SMDI

Without the Unity Integration Guide  Program the phone system 
by doing the following procedure.

With the Unity Integration Guide  Program the phone system by 
using the related chapter in the guide.

DO THIS SECTION?

TURNKEY 
SYSTEM

YES NO
see

page

All configurations ✓

COMPONENT 
SYSTEM

All configurations ✓
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To program the phone system

This procedure provides general information about programming 
a phone system; refer to the phone system documentation for 
specific information.

a Assign extensions for the voice messaging ports.

b If the phone system supports hunt groups, program the 
hunting order for the voice messaging extensions (port 1 to 
port 2, and so on).

If the phone system does not support hunt groups, you can 
simulate a hunt group by forwarding each voice messaging 
extension to the next extension in the simulated hunt group 
on busy.

c If the phone system supports hunt group access codes, 
assign a hunt group access code for the voice messaging 
extensions. This code is the number that subscribers dial 
internally to connect to the Unity server.

d Program which trunks (if any) will route to the voice messag-
ing extensions.

e Program the phone system to handle calls when all voice 
messaging ports are busy. Calls may be forwarded to an 
operator, get a busy signal, or get a ringback tone until one 
of the ports becomes available.

Next section

TURNKEY SYSTEM

All configurations “Testing the integration,” on page 92

COMPONENT SYSTEM

All configurations “Testing the integration,” on page 92
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Testing the 
integration

In this section, you test whether Unity and the phone system are 
integrated correctly.

Unity comes with a test subscriber, Example Subscriber. First, 
you assign an extension to Example Subscriber so that you can 
leave a message. Then, you use Example Subscriber to test the 
integration.

To assign an extension to the test subscriber

This procedure sets call transfer options only for Example Sub-
scriber. Call transfer options for actual subscribers are set later, 
and are described in the Unity System Administration Guide.

a In the Unity Administrator, go to Subscribers > 
Subscribers > Profile.

b If Example Subscriber is not displayed, click the Find icon, 
then click “Find,” and select “Example Subscriber” in the 
list that appears.

c In the “Extension” box, type the extension for Example Sub-
scriber. This extension should be near your work area, so 
you can hear it ring.

d Click the Save icon.

DO THIS SECTION?

TURNKEY 
SYSTEM

YES NO
see

page

All configurations ✓

COMPONENT 
SYSTEM

All configurations ✓

bd

e

c
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e In the navigation bar, click “Call transfer” to go to 
Subscribers > Subscribers > Call Transfer for Example 
Subscriber.

f Confirm that incoming calls are set to transfer to Example 
Subscriber’s extension.

g Select a transfer type. If the phone system does not forward 
calls to the subscriber’s greeting, use “Supervise transfer.” 

h Select the number of rings to wait before Unity recalls a call.

i If you made a change, click the Save icon.

Continued

f

g

h

i
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Testing the 

Continued

integration
To test the voice messaging ports

a From a test extension, call each port. Refer to the System > 
Ports page for the extension of each port, if necessary. Con-
firm that each port answers.

b Press a touchtone key as a Unity conversation prompt plays. 
The prompt should stop. If it does not, see “Unity does not 
respond to touchtones,” in Chapter 3 of the Unity Trouble-
shooting Guide.

To test release transfers

If you are not using release transfers, skip this test.

a Disconnect a line from Unity and connect it to a test phone 
(Phone 1). This may require a line splitter or a breakout box. 
For information on setting up the test, see “Troubleshooting 
preparation,” in Chapter 1 of the Unity Troubleshooting 
Guide.

b From an extension that is connected to the phone system 
but that will not be connected to Unity (Phone 2), dial the 
access code necessary to get an outside line, then call 
Phone 1.

c Answer Phone 1.

d On Phone 1, flash the hookswitch, or press the “Flash” 
button.

e On Phone 1, dial a third extension, (Phone 3). If the phone 
system requires an override digit to force ringing, dial it.

f Hang up Phone 1.

g Answer Phone 3.

If the transfer succeeds (if Phone 2 is connected to Phone 3), 
release transfers work. Reconnect lines to the Unity server.

If the transfer fails, see “Release transfers are not being per-
formed correctly,” in Chapter 3 of the Unity Troubleshooting 
Guide.
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To test supervised transfers

If you are not using supervised transfers, skip this test.

a Disconnect a line from Unity and connect it to a test phone 
(Phone 1). This may require a line splitter or a breakout box. 
For information on setting up the test, see “Troubleshooting 
preparation,” in Chapter 1 of the Unity Troubleshooting 
Guide.

b From an extension that is connected to the phone system 
but that will not be connected to Unity (Phone 2), dial the 
access code necessary to get an outside line, then call 
Phone 1.

c Answer Phone 1.

d On Phone 1, flash the hookswitch, or press the “Flash” 
button.

e On Phone 1, dial a third extension, (Phone 3). If the phone 
system requires an override digit to force ringing, dial it.

f If you hear the ringback tone, answer Phone 3 and hang up 
Phone 1.

If the transfer succeeds (if Phone 2 is connected to Phone 3), 
supervised transfers work. Reconnect lines to the Unity 
server.

If the transfer fails, see “Supervised transfers are not being 
performed correctly,” in Chapter 3 of the Unity Troubleshoot-
ing Guide.

To test external number access

Dial an external number from the test extension. You 
should reach the number. If you do not, the problem is with 
the phone system.

Continued
CHAPTER 4: Setting up the integration 95



Testing the 

Continued

integration
To view port status

In the final four test procedures, use the Status Monitor to deter-
mine whether Unity’s ports are handling calls correctly.

NOTE: The Status Monitor requires Internet Explorer version 5 or 
later.

a On the Unity server, double-click the desktop shortcut to 
the Status Monitor.

b Click the Port Status icon. 

b
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To test whether Unity detects hangups

a Call Unity from an external line. You should hear the open-
ing greeting and see in the Status Monitor that Unity is 
answering with the opening greeting.

b Hang up. The call should disappear from the Status 
Monitor. 

If the call does not disappear, and if the Unity server con-
tains Dialogic voice boards, run the Learn Tones utility and 
select the CO disconnect option. For information, see “The 
Learn Tones utility,” in Chapter 9 of the Unity Troubleshoot-
ing Guide.

c Call Unity again, this time from an internal line. You should 
hear the opening greeting and see in the Status Monitor that 
Unity is answering with the opening greeting.

d Hang up. The call should disappear from the Status 
Monitor. 

If the call does not disappear, and if the Unity server contains 
Dialogic voice boards, run the Learn Tones utility and select the 
dial tone option. For information, see “The Learn Tones utility,” 
in Chapter 9 of the Unity Troubleshooting Guide.

To test call forward to personal greeting and message 
waiting indication

a Call Unity from an external line. You should hear the open-
ing greeting and see in the Status Monitor that Unity is 
answering with the opening greeting.

b When the automated attendant asks for an extension, enter 
the extension for Example Subscriber. The Status Monitor 
should indicate that the call is being transferred, and the 
phone should ring. Do not answer it.

c Listen for the prerecorded Example Subscriber greeting.

d Leave a message that is at least 5 seconds long.

e Confirm that the message waiting indicator (MWI) on the 
phone assigned to Example Subscriber is on.

If the MWI is not on, see Chapter 5 of the Unity Trouble-
shooting Guide.

Continued
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Testing the 

Continued

integration
f Retrieve the message and confirm that the message waiting 

indicator is off.

If the MWI is not off, see Chapter 5 of the Unity Trouble-
shooting Guide.

To test the hunt group

a Busy the first voice messaging port.

b From an external line, call the test extension. The first avail-
able port should take the call.

c Busy the next port, and repeat step b.

d Repeat step c until all the ports have been busied. When all 
the ports are busied, the phone system should do whatever 
you programmed it to do when all lines are busy. If some-
thing else happens, check the phone system programming.

To test identified subscriber messaging

Call the test extension from another extension. The Status 
Monitor should identify the extension from which you are 
calling. 

If the extension is not identified, either the phone system 
does not support identified subscriber messaging or there is 
a problem with the phone system.

Next section

TURNKEY SYSTEM

All configurations What’s next, page 113

COMPONENT SYSTEM

All configurations What’s next, page 113
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Upgrading a 
Unity or 
ActiveFax 
server

This section contains procedures that you do if you are:

◆ Upgrading Unity and ActiveFax software on the Unity server 
from version 2.3 to version 2.4

◆ Moving ActiveFax from the Unity server to a separate fax 
server.

◆ Adding or changing voice boards in the Unity server.

◆ Adding or changing fax boards in the Unity or ActiveFax 
server.

Do the procedures that apply to your situation, and do them in 
the order listed.

Included in this section are procedures to remove different 
brands of voice board software. Do the procedure(s) that apply to 
your voice board brand(s).

CAUTION: You must uninstall voice board software before you 
upgrade to Unity 2.4, or the upgrade will fail.

If you only want to add or remove languages after you have 
upgraded to Unity version 2.4, see “Adding or removing lan-
guages,” on page 111.

Backing up the Unity server
Back up the Unity server in case the upgrade process fails and 
you need to restore the Unity server to its original state. Use 
whatever process you normally use to back up the entire con-
tents of the Unity server.

Removing Dialogic voice board software
Do the following two procedures if the Unity server contains Dia-
logic voice boards, and if you are:

◆ Upgrading Unity software to version 2.4.

◆ Adding or changing voice boards, even if you are adding 
boards of the same type. 
UNITY INSTALLATION GUIDE100



To determine the current setting for the Dialogic quiet 
parameter

When the Dialogic quiet parameter has been set to a value other 
than the default, the setting will be lost when you remove the 
Dialogic software. Write down the current value of the quiet 
parameter so you can restore that value after you reinstall the 
software.

a Shut down Unity if it is running.

b On the Windows Start menu, click Programs > Dialogic Sys-
tem Software > Dialogic Configuration Manager to start the 
DCM. 

The tree-structured list contains an entry for each Dialogic 
board installed in the server.

c On the Service menu, click “Stop service.”

d Double-click any voice board in the tree list. The Properties 
dialog box for the board appears.

e Click the Misc tab.

f Under “Parameter,” note and write down the value of 
“ParameterFile.”

g Click “OK.”

To remove Dialogic software

a Shut down Unity if it is running.

b On the Windows Start menu, click Programs > Dialogic Sys-
tem Software > Dialogic Configuration Manager–DCM.

c On the Service menu, click “Stop service.”

d Close the DCM.

e On the Windows Start menu, click Settings > Control Panel.

f Double-click “Telephony.” The Dialing Properties dialog box 
appears.

g Click the Telephony Drivers tab.

Continued
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Upgrading a Unity or 

Continued

ActiveFax server
h Click “Dialogic generation 2 service provider for NT.”

If you are using D/160SC voice boards and VoiceBridge 
2000 feature-set boards, this option will say “DSE Service 
provider.”

i Click “Remove.”

j Click “Close” to close the Dialing Properties dialog box.

k In Control Panel, double-click “Multimedia.” The Multimedia 
Properties dialog box appears.

l Click the Devices tab.

m Expand “Audio devices.”

n Click “Audio for Dialogic WAVE Driver 1.x” or “Audio for 
dlgwave.dll.”

o Click “Remove.”

p When prompted to restart, click “Don’t restart now.”

q Click “OK” to close the Multimedia Properties dialog box.

r Close Control Panel.

s On the Windows Start menu, click Programs > Dialogic Sys-
tem Software > Uninstall.

t Follow the on-screen instructions for the Dialogic software 
uninstall.

u When the dialog box asks whether you want to delete shared 
files, click “No to all.”

v If you are using D/160SC voice boards and VoiceBridge 
2000 feature-set boards, at the end of the uninstall, do not 
restart. Instead, skip to the next procedure, “To remove 
Voice Technologies Group software.”

Otherwise, click “Reboot.” (The Dialogic-triggered restart 
may not restart the system; in this case, manually restart.)

w After restarting, log on.

x With Windows Explorer, browse to the directory where Unity 
is installed (C:\CommServer by default) and delete the 
TSPSetup directory.

NOTE: If you have already upgraded to Unity version 2.4, 
this directory does not exist.
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Removing Voice Technologies Group 
feature-set board software
Do the following procedure if the Unity server contains Dialogic 
D/160SC voice boards and Voice Technologies Group Voice-
Bridge 2000 feature-set boards, and if you are:

◆ Upgrading Unity software to version 2.4.

◆ Adding or changing voice boards, even if you are adding 
boards of the same type.

◆ Adding feature-set boards.

To remove Voice Technologies Group software

a On the Windows Start menu, click Settings > Control 
Panel > Add/Remove Programs.

b Remove “VoiceBridge 2000."

c When the dialog box asks whether you want to delete shared 
files, click “No to all.”

d Close the Add/Remove Programs dialog box.

e Shut down and restart the Unity server.

Continued
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Upgrading a Unity or 

Continued

ActiveFax server
Removing NMS voice board software
Do the following procedure if the Unity or ActiveFax server con-
tains NMS voice or fax boards, and if you are:

◆ Upgrading Unity software to version 2.4.

◆ Adding or changing voice boards, even if you are adding 
boards of the same type. 

◆ Changing from NMS fax boards to Dialogic fax boards in the 
Unity or ActiveFax server.

To remove NMS software

a Shut down Unity if it is running. 

b On the Windows Start menu, click Settings > Control Panel.

c Double-click “Telephony.” The Dialing Properties dialog box 
appears.

d Click the Telephony Drivers tab.

e Click “Natural MicroSystems service provider.”

f Click “Remove.”

g Click “OK” to close the Dialing Properties dialog box.

h In Control Panel, double-click “Multimedia.” The Multimedia 
Properties dialog box appears.

i Click the Devices tab.

j Expand “Audio devices.”

k Click “Audio for Natural MicroSystems telephony hardware.”

l Click “Remove.”
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m Click “OK” to close the Multimedia Properties dialog box.

n When prompted to restart, click “Don’t restart now.”

o In Control Panel, double-click “Add/remove programs.”

p Click the Install/Uninstall tab.

q Select “Natural MicroSystems Natural Access.”

r Click “Add/Remove.”

s When all NMS components have been uninstalled, close all 
programs and restart the server.

t After restarting, log on.

u With Windows Explorer, browse to the root directory and 
delete the NMS directory.

Adding or changing voice or fax boards 
Do the following procedure if you are adding or changing voice or 
fax boards, even if you are adding boards of the same type. 

To add or change voice or fax boards in the Unity or 
ActiveFax server

Do the procedure “To install voice or fax boards,” on 
page 35.

Continued
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Upgrading a Unity or 

Continued

ActiveFax server
Installing Microsoft Data Access Components
Do the following procedure if you are upgrading Unity software 
to version 2.4.

To install MDAC version 2.5 or later

a Insert the Unity compact disc in the CD-ROM drive.

b Browse to the directory Mdac.

c Run Mdac_typ.exe.

Upgrading the Unity software and installing 
ActiveFax

To install ActiveFax on a separate server

Do this procedure if you are moving ActiveFax from the Unity 
server to a separate server.

You install ActiveFax first. When you upgrade the Unity software 
on the Unity server, you are prompted to specify the name of the 
server on which ActiveFax is installed. The Unity Setup program 
then verifies that ActiveFax is running on that server.

a Confirm that the ActiveFax system key is connected to the 
ActiveFax server.

b Confirm that all fax boards have been installed and set up 
according to the “Hardware settings” instructions for your 
boards in Appendix A.

c Log on to Windows NT/2000 by using the account you chose 
to use for installation. For more information, see “The 
account used for installation on the Unity server,” on 
page 69.

d Insert the Unity compact disc in the CD-ROM drive.

e Browse to the root directory of the Unity compact disc, and 
run Setup.exe.

f Choose the language in which you want to view Setup 
prompts, and click “OK.” A welcome message appears.
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g Click “Next,” and Setup examines your system to confirm 
that the required software is installed and configured prop-
erly and that a system key is installed.

If an error message appears, correct the specified problem, 
then rerun Setup.

h Follow the on-screen prompts.

i When you are prompted to select the features you want to 
install, select the “Install fax server” check box. (If the check 
box is not available, the system key does not include the 
option to install ActiveFax.)

If the ActiveFax server contains NMS fax boards, also select 
the “Install voice board software” check box.

j Follow the on-screen prompts to complete the installation.

k Restart the ActiveFax server.

To remove ActiveFax from the Unity server

Do this procedure if you are moving ActiveFax from the Unity 
server to a separate server.

a On the Windows Start menu, click Settings > Control Panel.

b Double-click “Add/remove programs.”

c Remove the following programs in the order listed:

◆ LightningFAX 6.5 - LFExGateway

◆ LightningFAX 6.5 - FAXTOMAIL (if it is installed)

◆ LightningFAX 6.5 - CLIENT

◆ LightningFAX 6.5 - RASTERIZATION SERVER

◆ LightningFAX 6.5 - DRIVER

◆ LightningFAX 6.5 - SERVER

◆ LightningFAX 6.5 - USYNC

◆ LightningFAX 6.5 - ACTIVEX CONTROLS

d Close the Add/Remove Programs dialog box.

Continued
CHAPTER 5: Upgrading hardware and software 107



Upgrading a Unity or 

Continued

ActiveFax server
To upgrade the Unity and ActiveFax software on the 
Unity server

Do this procedure if you are:

◆ Upgrading Unity and ActiveFax software to version 2.4.

◆ Adding or changing voice boards, even if you are adding 
boards of the same type. 

NOTE: When you upgrade the Unity software, any diagnostic 
traces that were turned on are automatically turned off.

a Confirm that the Unity system key is connected to the Unity 
server.

b Confirm that all voice and fax boards have been installed 
and set up according to the “Hardware settings” instruc-
tions for your boards in Appendix A.

If you are installing a component system and the server 
contains Dialogic D/41D or D/42-NE2 ISA voice boards, 
note the setting of jumper JP1 (IRQ setting) because you 
must enter that value at the end of the Setup program.

c Start the Unity server.

d Log on to Windows NT/2000 by using the account you chose 
to use for installation. For more information, see “The 
account used for installation on the Unity server,” on 
page 69.

e Insert the Unity compact disc in the CD-ROM drive.

f Browse to the root directory of the Unity compact disc, and 
run Setup.exe.

g Choose the language in which you want to view Setup 
prompts, and click “OK.” A welcome message appears.

h Click “Next,” and Setup examines your system to confirm 
that the required software is installed and configured prop-
erly, and that a system key is installed.

If an error message appears, correct the specified problem, 
then rerun Setup.

i Follow the on-screen prompts.
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j When you are prompted to select the features you want to 
install, select the “Upgrade Unity” and “Install voice board 
software” check boxes. If you already installed ActiveFax on 
a separate server or if you want to install ActiveFax on the 
Unity server, also select the “Install fax server” check box. (If 
ActiveFax is installed on another server, you still need to 
install the Exchange fax gateway on the Unity server.)

If the “Install fax server” check box is not available, the sys-
tem key does not include the option to install ActiveFax on 
the Unity server.

k Follow the on-screen prompts to continue the installation.

l After the Unity software is installed and configured, you are 
prompted to enter settings for the voice boards in the Unity 
server. Do the “Software setup” procedures for your voice 
boards in Appendix A.

m Follow the on-screen prompts to complete the installation.

n Restart the Unity server.

To set up fax boards for ActiveFax

Do this procedure if you are:

◆ Upgrading Unity and ActiveFax software to version 2.4.

◆ Moving ActiveFax from the Unity server to a separate server.

◆ Adding or changing fax boards.

Do the procedures in “Setting up fax ports for ActiveFax,” on 
page 75.

Continued
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Upgrading a Unity or 

Continued

ActiveFax server
Resetting the Dialogic quiet parameter
Do the following procedure if the Unity server contains Dialogic 
voice boards and if you are:

◆ Upgrading Unity and ActiveFax to version 2.4

◆ Adding or changing voice boards, even if you are adding 
boards of the same type.

You reset the quiet parameter to the value you identified in the 
procedure “To determine the current setting for the Dialogic 
quiet parameter,” on page 101.

To reset the quiet parameter (Dialogic voice boards 
only)

a Shut down Unity if it is running.

b On the Windows Start menu, click Programs > Dialogic Sys-
tem Software > Dialogic Configuration Manager–DCM. 

The tree-structured list contains an entry for each Dialogic 
board installed in the server.

c On the Service menu, click “Stop service.”

d Double-click the first board in the tree list. The Properties 
dialog box for the board appears.

e Click the Misc tab.

f Under “Parameter,” click “ParameterFile.”

g In the “Value” box, type quietXX.prm (where XX = the 
-dBm level of the desired quiet parameter file; for example, 
quiet50.prm).

h Click “OK.”

i Repeat steps d through h for any additional boards.

j Shut down and restart the Unity server.
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Adding or 
removing 
languages

The Unity installation discs include all of the files for all of the 
languages in which Unity is available. You can install as many 
languages as you want. The Unity system key specifies how 
many of these languages can be available at one time.

If you want to use more languages than are currently allowed by 
your system key, contact your Unity dealer about upgrading the 
key.

CAUTION: You must use the compact discs for the version of 
Unity currently installed to add or remove languages. If the discs 
are for a different version, you must do a full upgrade by using the 
procedures under “Upgrading a Unity or ActiveFax server,” on 
page 100.

For more information on languages, see “Setting up multiple lan-
guages,” in Chapter 6 of the Unity System Administration Guide.

To add or remove languages

a Shut down Unity if it is running.

b Log on to Windows NT/2000 by using the domain adminis-
trator account.

c Insert Unity compact disc 1 in the CD-ROM drive.

d Browse to the root directory of the Unity compact disc, and 
run Setup.exe.

e Follow the on-screen prompts.

f When you are prompted to select the features you want to 
install, select only the “Upgrade Unity” check box.

g Follow the on-screen prompts.

h When you are prompted to select languages, select check 
boxes for the languages that you want to install and clear 
check boxes for the languages that you want to remove.

i Follow the on-screen prompts to complete the installation.

j Restart the Unity server.
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System key 
upgrades

The Unity system key controls access to certain Unity features 
(for example, the licensed number of voice ports and the phone 
system integration).

For information about adding licenses or features to the system 
key, contact your Unity dealer.
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■ WHAT’S NEXT
You have completed the installation and preliminary setup 
tasks. If you are continuing the Unity setup, see the Unity Sys-
tem Administration Guide to:

◆ Work with the system administrator to make decisions 
about system configuration.

◆ Customize system settings.

◆ Define classes of service.

◆ Add subscribers.

◆ Create distribution lists.

◆ Set up restriction tables.

◆ Set up routing tables.

◆ Back up the system.

◆ Train subscribers.

If ActiveFax was installed as part of the Unity installation, see 
the Unity System Administration Guide to:

◆ Set up inbound fax routing.

◆ Enter fax profile settings.

◆ Set up subscribers to receive faxes.

◆ Enter class of service licensed feature settings.
113
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Dialogic 
D/41D  
voice board

����������

Switch block SW1

Jumpers JP5 and JP6

Side view

Top view

Jumper JP7 Jumper JP1

Voice board backplateConnection pinouts
The D/41D uses 
RJ-14 connectors.

Lines 1 & 2

Lines 3 & 4Pin 1: Second port tip

Pin 2: First port tip

Pin 3: First port ring

Pin 4: Second port ring
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Hardware settings
Do the following procedures as you install voice boards.

To set switch block SW1 and jumpers JP5, JP6, 
and JP7

The switch block SW1 and jumper JP6 settings identify the voice 
board’s memory address, which in turn specifies which voice 
messaging ports are on which board. The jumper JP7 setting 
specifies which board is in the first slot.

a Set SW1 switches on each board:

Turnkey system Set SW1 switches as shown below.

Component system Set SW1 switches to values that you 
identified in the procedure “To find and reserve memory 
addresses and an IRQ (ISA boards in a component system 
only),” on page 35.

b Set jumpers JP5, JP6, and JP7 as shown below.

To set jumper JP1 (IRQ setting)

Set jumper JP1 on all boards to position 4, IRQ 5, as shown 
in the diagram at left.

Continued

SW1 JP5 JP6 JP7
Memory 
address

First board
Ports 1–4

D0000

Second board
Ports 5–8

D2000

Third board
Ports 9–12

D4000

Fourth board
Ports 13–16

D6000

On
Off

1 2 3 4

On
Off

1 2 3 4

On
Off

1 2 3 4

On
Off

1 2 3 4

���
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Dialogic D/41D  

Continued

voice board
Software settings
During Unity Setup, do the following procedure when the Dia-
logic Board Configuration dialog box appears.

To enter Dialogic settings during Unity Setup

a Change the value of “Number of boards” to the number of 
Dialogic D/41D boards in the server.

b Change the value of “IRQ” to “5.”

c In the Board Addresses list, select one address for each 
D/41D board in the server:

Turnkey system Start with “0xD0000” and select consecu-
tive values.

Component system Select the addresses that you reserved 
during the procedure “To find and reserve memory 
addresses and an IRQ (ISA boards in a component system 
only),” on page 35.

d Click “OK” to continue.

e Return to the procedure that you were doing when the Dia-
logic Board Configuration dialog box appeared.
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Dialogic 
D/41E PCI 
voice board

Continued

Jumpers
JP2–JP5

Jumpers 
JP6–JP7Switch

SW1
Switch 
SW2

Voice board backplate

Line 1

Line 2

Connection pinouts
The D/41E PCI uses 
RJ-11 connectors.

Line 3

Line 4

Side view

Pin 4: Unused

Pin 3: Ring

Pin 2: Tip

Pin 1: Unused
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Dialogic D/41E PCI 

Continued

voice board
Hardware settings
Do the following procedures as you install voice boards.

To set the SW1 switch

For each Dialogic PCI voice board that has a rotary switch, 
set the rotary switch to a unique value starting with 1 and 
continuing in sequence.

For example, set the rotary switch on the first three PCI 
voice boards in the Unity server as shown below. This is also 
the order in which you install the boards in the server. 

To set switch block SW2

Set SW2 switches to “Off” on all boards.

To set jumpers JP2 to JP7

Set jumpers JP2 to JP5 to “Off” on each board. For jumpers 
JP6 and JP7, install shunts on the top two pins (1 and 2). 

Software settings
None.

First PCI board

Second PCI board

Third PCI board

JP2 JP3 JP4 JP5 JP6 JP7

Setting

1

2

3
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Dialogic 
D/41ESC 
voice board

Continued

0

����

Voice board backplate

SC bus connector Switch SW1 Switch block SW2

Top view

Side view

Pin 4: Unused

Connection pinouts
The D/41ESC uses 
RJ-11 connectors.

Line 1

Line 2

Line 3

Line 4

Pin 1: Unused

Pin 2: Tip

Pin 3: Ring
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Dialogic D/41ESC 

Continued

voice board
Hardware settings
Do the following procedures as you install voice boards.

To set the SW1 switch

For each Dialogic ISA voice board that has a rotary switch, 
set the rotary switch to a unique value starting with 0 and 
continuing in sequence. 

For example, set the rotary switch on the first three ISA 
voice boards in the Unity server as shown below. This is also 
the order in which you install the boards in the server. 

To set switch block SW2

Set SW2 switches to “Off” on all boards.

First ISA board

Second ISA board

Third ISA board

0

1

2
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Software settings
During Unity Setup, do the following procedure when the Dia-
logic D/SC Configuration dialog box appears.

To enter Dialogic settings during Unity Setup

a Change the value of “BLTInterrupt” to “5.”

b Change the value of “BLTAddress” to the appropriate value:

Turnkey system Select “D0000.”

Component system Select the address that you reserved 
during the procedure “To find and reserve memory 
addresses and an IRQ (ISA boards in a component system 
only),” on page 35.

c Click “OK” to continue.

d Return to the procedure that you were doing when the Dia-
logic D/SC Configuration dialog box appeared.
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Dialogic 
D/41ESC-Euro 
voice board

0

����

Voice board backplate

SC bus connector Switch SW1 Switch block SW2

Top view

Side view

Pin 4: Unused

Connection pinouts
The D/41ESC-Euro uses 
RJ-11 connectors.

Line 1

Line 2

Line 3

Line 4

Pin 1: Unused

Pin 2: Tip

Pin 3: Ring
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Hardware settings
Do the following procedures as you install voice boards.

To set the SW1 switch

For each Dialogic ISA voice board that has a rotary switch, 
set the rotary switch to a unique value starting with 0 and 
continuing in sequence.

For example, set the rotary switch on the first three ISA 
voice boards in the Unity server as shown below. This is also 
the order in which you install the boards in the server.

To set switch block SW2

Set SW2 switches to “Off” on all boards.

Software settings
During Unity Setup, do the following procedures when the Dia-
logic D/SC Configuration dialog box appears.

To enter Dialogic settings during Unity Setup

a Change the value of “BLTInterrupt” to “5.”

b Change the value of “BLTAddress” to the appropriate value:

Turnkey system Select “D0000.”

Component system Select the address that you reserved 
during the procedure “To find and reserve memory 
addresses and an IRQ (ISA boards in a component system 
only),” on page 35.

c Do not click “OK” to continue. Instead, continue with the 
next procedure.

Continued

First ISA board

Second ISA board

Third ISA board

0

1

2
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Dialogic 
D/41ESC-Euro 

Continued

voice board

To set the parameter file for the D/41ESC-Euro board

a On the Windows Start menu, click Programs > Dialogic Sys-
tem Software > Dialogic Configuration Manager–DCM.

The tree-structured list contains an entry for each Dialogic 
board installed in the server. Note that the D/41ESC-Euro 
board is displayed in the list as “D/41ESC.”

b Double-click the first occurrence of “D/41ESC” in the tree 
list. The Properties dialog box for the board appears.

c Click the Country tab.

d Change the value of “Country” to “Euro (CTR-21).”

e Click “OK.”

f To set additional D/41ESC-Euro boards, double-click the 
next occurrence of “D/41ESC” in the list and repeat steps 
c through e.

g Close the DCM.

h In the Dialogic D/SC Configuration dialog box, click “OK” to 
continue with Unity setup.

i Return to the procedure that you were doing when the Dia-
logic D/SC Configuration dialog box appeared.
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Dialogic 
D/120JCT-LS 
voice board

Continued

Voice board backplateConnection pinouts
The D/120JCT-LS uses 
RJ-25 connectors.

Lines 1 and 2

Lines 3 and 4

Lines 5 and 6

Lines 7 and 8

Pin 6: Earth recall 2

Pin 5: Ring 2

Pin 4: Tip 1

Pin 3: Ring 1

Pin 2: Tip 2

Pin 1: Earth recall 1

Switch SW100Switch SW1

Side view

Top view

Lines 9 and 10

Lines 11 and 12

CT bus connector
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Dialogic 
D/120JCT-LS voice 

Continued

board

Hardware settings
Do the following procedures as you install voice boards.

To set the SW100 switch

◆ For each Dialogic PCI voice board that has a rotary switch, 
set the rotary switch to a unique value starting with 1 and 
continuing in sequence. 

For example, set the rotary switch on the first three PCI 
voice boards in the Unity server as shown below. This is also 
the order in which you install the boards in the server. 

To set the SW1 switch

Set switch SW1 to “On hook” on all boards as shown below.

Software settings
None.

First PCI board

Second PCI board

Third PCI board

1

2

3

On hook
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Dialogic 
D/160SC 
voice board

Continued

SC bus connector

Side view

Top view

Switch SW 100
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Dialogic D/160SC 

Continued

voice board
Use the Dialogic D/160SC voice board with the VTG VoiceBridge 
2000 feature-set board to provide feature-set integration on 
Mitel SX-200 and SX-2000 phone systems.

All of the D/160SC and VoiceBridge 2000 boards that you are 
installing must be in the same box because they all must be con-
nected with an SC bus cable. If there are not enough slots in the 
Unity server, then you must put all of the boards into an expan-
sion chassis.

Hardware settings
Do the following procedures as you install voice boards.

The IRQ for Dialogic D/160SC boards is 2 on all Unity turnkey 
systems except the Dell 2400. On the Dell 2400, the IRQ for 
D/160SC boards is 5.

To set the SW100 switch

For each Dialogic ISA voice board that has a rotary switch, 
set the rotary switch to a unique value starting with 0 and 
continuing in sequence. 

For example, set the rotary switch on the first three ISA 
voice boards in the Unity server as shown below. This is also 
the order in which you install the boards in the server. 

First ISA board

Second ISA board

Third ISA board

0

1

2
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Software settings
During Unity Setup, the Dialogic D/SC Configuration dialog box 
appears. Do the following procedure after you have done the pro-
cedure “To enter VoiceBridge 2000 settings during Unity Setup,” 
on page 161.

To enter Dialogic settings during Unity Setup

a Change the value of “BLTInterrupt” to the appropriate value:

All turnkey systems, except Dell 2400 Select “2.”

Dell 2400 turnkey system Select “5.”

Component system Select the IRQ that you reserved dur-
ing the procedure “To find and reserve memory addresses 
and an IRQ (ISA boards in a component system only),” on 
page 35.

b Change the value of “BLTAddress” to the appropriate value:

Turnkey system Select “D0000.”

Component system Select the address that you reserved 
during the procedure “To find and reserve memory 
addresses and an IRQ (ISA boards in a component system 
only),” on page 35.

c Click “OK” to continue.

d Return to the procedure that you were doing when the Dia-
logic D/SC Configuration dialog box appeared.
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Dialogic 
D/160SC-LS 
voice board

SC bus
connector

Switch
SW100

Switch 
SW600

DB-37 connector

Top view

Side view

Connection pinouts
The D/160SC-LS uses a DB-37 
connector. See the table on the 
next page for pinout information.

Pin 1 Pin 20
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DB-37 pinouts

◆ Pin 37 is the ground.

◆ Pins 17, 34, 35, and 36 are unused.

Continued

Line number Tip connection Ring connection

1 Pin 1 Pin 18

2 Pin 2 Pin 19

3 Pin 3 Pin 20

4 Pin 4 Pin 21

5 Pin 5 Pin 22

6 Pin 6 Pin 23

7 Pin 7 Pin 24

8 Pin 8 Pin 25

9 Pin 9 Pin 26

10 Pin 10 Pin 27

11 Pin 11 Pin 28

12 Pin 12 Pin 29

13 Pin 13 Pin 30

14 Pin 14 Pin 31

15 Pin 15 Pin 32

16 Pin 16 Pin 33
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Dialogic D/160SC-LS 

Continued

voice board
Hardware settings
Do the following procedures as you install voice boards.

To set the SW100 switch

For each Dialogic ISA voice board that has a rotary switch, 
set the rotary switch to a unique value starting with 0 and 
continuing in sequence. 

For example, set the rotary switch on the first three ISA 
voice boards in the Unity server as shown below. This is also 
the order in which you install the boards in the server. 

To set the SW4 switch

Set switch SW4 to “Off hook” on all boards as shown below.

First ISA board

Second ISA board

Third ISA board

0

1

2

Off hook
UNITY INSTALLATION GUIDE134



Software settings
During Unity Setup, do the following procedure when the Dia-
logic D/SC Configuration dialog box appears. 

To enter Dialogic settings during Unity Setup

a Change the value of “BLTInterrupt” to “5.”

b Change the value of “BLTAddress” to the appropriate value:

Turnkey system Select “D0000.”

Component system Select the address that you reserved 
during the procedure “To find and reserve memory 
addresses and an IRQ (ISA boards in a component system 
only),” on page 35.

c Click “OK” to continue.

d Return to the procedure that you were doing when the Dia-
logic D/SC Configuration dialog box appeared.
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Dialogic 
D/240PCI-T1 
voice board

Switch SW100

Top view

Side view

Voice board 
backplate

LED status
indicators

T1 trunk
interface

O
N

1

Pin 1: Receive ring

Pin 2: Receive tip

Pin 3: Chassis ground

Pin 4: Transmit ring

Pin 5: Transmit tip

Pin 6: Chassis ground

Pin 7: Chassis ground

Pin 8: Chassis ground

Connection pinouts
The D/240PCI-T1 uses an 
RJ-48C connector.

JP2–JP7CT bus connector
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Hardware settings
Do the following procedures as you install voice boards.

To set the SW100 switch

For each Dialogic PCI voice board that has a rotary switch, 
set the switch to a unique value starting with 1 and con-
tinuing in sequence. For example, set the switch on the first 
three PCI voice boards in the Unity server as shown below. 
Install the boards in the server in the same order. 

To set jumpers JP2 to JP7

Set jumpers JP2 to JP5 to “Off” on each board. For jumpers 
JP6 and JP7, install shunts on the top two pins (1 and 2). 

Software settings
None.

LED status indicators
The D/240PCI-T1 includes the following status indicators.

First PCI board

Second PCI board

Third PCI board

JP2 JP3 JP4 JP5 JP6 JP7

Setting

Color Lit

Green The board is powered up and receiving an external signal

Yellow Loss of frame synchronization at far end external network

Red Loss of frame synchronization on incoming line from external 
network

1

2

3
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Dialogic 
GammaLink 
CP4/LSI 
Series 1 
fax board

Pin 3: First fax line tip

Pin 2: First fax line ring

Connection pinouts
The CP4/LSI Series 1 
uses RJ-11 connectors.

Pin 1: Second fax line tip

Pin 4: Second fax line ring

Pin 3: Third fax line tip

Pin 2: Third fax line ring

Pin 1: Fourth fax line tip

Pin 4: Fourth fax line ring

Switch block SW1Side view

Fax board backplate

Lines 3 & 4

Lines 1 & 2

LED status indicators

Switch block SW1Side view
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Hardware settings
Do the following procedure as you install fax boards.

To set switch block SW1

The switch block SW1 settings determine the fax ports’ I/O 
addresses.

The CP4/LSI Series 1 board contains four fax ports. Depending 
on the configuration of the Unity server and on whether Active-
Fax is installed on a separate server, you can install up to eight 
CP4/LSI Series 1 boards.

Set the SW1 switches on each board as shown below.

LED status indicators
There are two LED status indicators for each fax port. The fol-
lowing table describes the meaning of the status indicators.

SW1
switch

SW1
switch

First board
Ports 0–3

Fourth board
Ports 12–15

Second board
Ports 4–7

Fifth board
Ports 16–19

Third board
Ports 8–11

Sixth board
Ports 20–23

Color Lit Unlit Blinking

Green Port is off hook Port is on hook ---

Amber Board is 
operational

Board is not 
operational

Board configuration 
problem

On
Off

1 2 3

On
Off

1 2 3

On
Off

1 2 3

On
Off

1 2 3

On
Off

1 2 3

On
Off

1 2 3
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Dialogic 
GammaLink 
CP4/LSI 
Series 2 
(CPi/400) 
fax board

Pin 3: First fax line tip

Pin 2: First fax line ring

Connection pinouts
The CP4/LSI Series 2 
uses RJ-11 connectors.

Pin 1: Second fax line tip

Pin 4: Second fax line ring

Pin 3: Third fax line tip

Pin 2: Third fax line ring

Pin 1: Fourth fax line tip

Pin 4: Fourth fax line ring

LED status indicatorsRotary switch

Fax board backplate

Lines 3 & 4

Lines 1 & 2

Side view
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The CP4/LSI Series 2 fax board is also known as the CPi/400.

Hardware settings
Do the following procedure as you install fax boards.

To set the rotary switch

The rotary switch setting determines the fax ports’ I/O 
addresses.

The CP4/LSI Series 2 board contains four fax ports. Depending 
on the configuration of the Unity server and on whether Active-
Fax is installed on a separate server, you can install up to eight 
CP4/LSI Series 2 boards.

Set the rotary switch on each board as shown below.

LED status indicators
There are two LED status indicators for each fax port. The fol-
lowing table describes the meaning of the status indicators.

Rotary
switch

Rotary
switch

First board
Ports 0–3

Fourth board
Ports 12–15

Second board
Ports 4–7

Fifth board
Ports 16–19

Third board
Ports 8–11

Sixth board
Ports 20–23

Color Lit Unlit Blinking

Green Port is off hook Port is on hook ---

Amber Board is 
operational

Board is not 
operational

Board configuration 
problem

0 3

1 4

2 5
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Dialogic 
GammaLink 
CPD/220 
fax board

Fax board backplate

Pin 3: Tip 1

Pin 2: Ring 1

DID cable (miniature jack)

Miniature 
jack

Pin 1: Ring 2

Pin 4: Tip 2

RJ-11 
wall jack

LED status indicators

Pin 1: Ring 2
Pin 2: Ring 1
Pin 3: Tip 1
Pin 4: Tip 2

Switch block 
SW1

LSI cable (RJ-11 wall jack)

Side view
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Hardware settings
Do the following procedure as you install fax boards.

WARNING! Do not remove the cover from the server or expansion 
chassis while the power is on, if a CPD/220 fax board is already 
installed. The voltage level from the board can cause injury.

WARNING! Never connect a loop-start phone line to a DID fax 
port. The voltage in the loop-start line will damage the fax board. If 
you are unsure whether the line is a loop-start line, test it with a 
volt meter to confirm that there is no voltage.

To set switch block SW1

The switch block SW1 settings determine the fax ports’ I/O 
addresses. 

The CPD/220 board contains four fax ports. Depending on the 
configuration of the Unity server, you can install up to two 
CPD/220 boards.

Set the SW1 switches on each board as shown below.

LED status indicators
There are two LED status indicators for each fax port. The fol-
lowing table describes the meaning of the status indicators.

SW1
First board
Ports 0–3

Second board
Ports 4–7

Color Lit Unlit Blinking

Green Port is off hook Port is on hook ---

Amber Board is 
operational

Board is not 
operational

Board configuration 
problem

1 2 3 4 5 6

On
Off

1 2 3 4 5 6

On
Off
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Dialogic 
GammaLink 
CPi/200 
fax board

LED status indicators

Fax board backplate

Pin 3: First fax line tip

Pin 2: First fax line ring

Connection pinouts
The CPi/200 uses an 
RJ-14 connector.

Lines 1 & 2

Pin 1: Second fax line tip

Pin 4: Second fax line ring

Switch block SW1Side view
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Hardware settings
Do the following procedure as you install fax boards.

To set switch block SW1

The switch block SW1 settings determine the fax ports’ I/O 
addresses.

The CPi/200 board contains two fax ports. Depending on the 
configuration of the Unity server, you can install up to two 
CPi/200 boards.

Set the SW1 switches on each board as shown below.

LED status indicators
There are two LED status indicators for each fax port. The fol-
lowing table describes the meaning of the status indicators.

SW1
First board
Ports 0–1

First board
Ports 4–5

Color Lit Unlit Blinking

Green Port is off hook Port is on hook ---

Amber Board is 
operational

Board is not 
operational

Board configuration 
problem

On
Off

1 2 3

On
Off

1 2 3
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Dialogic 
GammaLink 
CPi/200 PCI 
fax board

LED status indicators

Fax board backplate

Pin 3: First fax line tip

Pin 2: First fax line ring

Connection pinouts
The CPi/200 PCI uses 
an RJ-11 connector.

Lines 1 & 2

Pin 1: Second fax line tip

Pin 4: Second fax line ring

Rotary switch

Side view

Top view
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Hardware settings
Do the following procedure as you install fax boards.

To set the rotary switch

The rotary switch setting identifies the fax board and specifies 
which fax ports are on which board. 

The CPi/200 PCI board contains two fax ports. Depending on the 
configuration of the Unity server, you can install up to four 
CPi/200 PCI boards.

Set the rotary switch on each board as shown below.

LED status indicators 
There are two LED status indicators for each fax port. The fol-
lowing table describes the meaning of the status indicators.

Switch

First board

Second board

Third board

Fourth board

Color Lit Unlit Blinking

Green Port is off hook Port is on hook ---

Amber Board is 
operational

Board is not 
operational

Board configuration 
problem

4

0 8

C

67
5

9A

B

1

2 3

DEF

4

0 8

C

67

5

9A

B

1

2 3

DEF
4

0 8

C

67

5

9A
B

1

2 3

DEF

4

0 8

C

67

5

9A

B

1

2 3

DEF
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Dialogic 
GammaLink 
CPi/400 PCI 
fax board

LED status indicators

Pin 3: First fax line tip

Pin 2: First fax line ring

Connection pinouts
The CPi/400 PCI uses 
RJ-11 connectors.

Pin 1: Second fax line tip

Pin 4: Second fax line ring

Rotary switch

Pin 3: Third fax line tip

Pin 2: Third fax line ring

Pin 1: Fourth fax line tip

Pin 4: Fourth fax line ring

Fax board backplate

Lines 3 & 4

Lines 1 & 2

Side view

Top view
UNITY INSTALLATION GUIDE148



Hardware settings
Do the following procedure as you install fax boards.

To set the rotary switch

The rotary switch setting identifies the fax board and specifies 
which fax ports are on which board. 

The CPi/400 PCI board contains four fax ports. Depending on 
the configuration of the Unity server, you can install up to eight 
CPi/400 PCI boards.

Set the rotary switch on each board as shown below.

LED status indicators
There are two LED status indicators for each fax port. The fol-
lowing table describes the meaning of the status indicators.

Switch Switch

First board Fourth board

Second board Fifth board

Third board Sixth board

Color Lit Unlit Blinking

Green Port is off hook Port is on hook ---

Amber Board is 
operational

Board is not 
operational

Board configuration 
problem

4

0 8

C

67
5

9A

B

1

2 3

DEF

4

0 8

C

67

5

9A

B

1

2 3

DEF

4

0 8

C

67

5

9A

B

1

2 3

DEF

4

0 8

C

67

5

9A

B

1

2 3

DEF

4

0 8

C

67

5

9A
B

1

2 3

DEF
4

0 8

C

67

5

9A
B

1

2 3

DEF
APPPENDIX A: Voice and fax boards 149



Natural 
MicroSystems 
AG 2000 
voice and fax 
board

Switch SW1H.100 bus connector

Voice board backplate

Lines 1 & 2

Lines 3 & 4

Lines 7 & 8

Pin 1: Not used

Pin 2: Tip 2

Pin 3: Ring 1

Pin 4: Tip 1

Pin 5: Ring 2

Pin 6: Not used

Connection pinouts
The AG 2000 uses 
RJ-14 connectors.

Lines 5 & 6

Side view
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Using AG 2000 boards
AG 2000 boards can be used for both voice and fax ports. 

The number of ports that are dedicated to fax is determined by 
the Unity system key. If you want more or fewer fax ports, you 
must upgrade the system key. For more information, see “Sys-
tem key upgrades,” on page 112.

A fax port can only send and receive faxes. It cannot answer 
voice calls.

If the AG 2000 boards are used for both voice and fax, voice 
ports are assigned first, beginning with the first port on the first 
board. Fax ports are then assigned, beginning with the next 
available port. The AG 2000 does not include a setting to desig-
nate board sequence, so you need to perform single-line tests to 
determine which ports are voice ports and which are fax ports. If 
Unity answers the call, the port is a voice port. If you hear the 
fax tone, the port is a fax port.

Continued
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Natural 
MicroSystems 
AG 2000 

Continued

voice and fax board

Hardware settings
Do the following procedure as you install voice boards.

To set the DIP switch that controls H.100 bus 
termination

The setting on the DIP switch on the AG 2000 board depends on 
how many boards you are installing:

One board  Set all switches to “Off.”

Two boards  Set all switches on both boards to “On.”

Three or more boards  Set all switches on the first and last 
boards to “On,” and set all switches on the middle boards to 
“Off.”

Number of boards Setting

One

Two Both boards

Three or more First and last boards

All other boards

1 2 3 4 5 6

On
Off

7 8

1 2 3 4 5 6

On
Off

7 8

1 2 3 4 5 6

On
Off

7 8

1 2 3 4 5 6

On
Off

7 8
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Software settings
During Unity Setup, do the following procedure when the NMS 
Country Selection dialog box appears. 

To enter AG 2000 settings during Unity Setup

a Select a country.

b Click “OK” to continue. 

c When the NMS Configurator dialog box appears, click “OK” 
to close it. 

d Return to the procedure that you were doing when the NMS 
Country Selection dialog box appeared.
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Natural 
MicroSystems 
AG-T1 
voice board

���������������	


�

I/O address DIP switch

T1 trunk interfaceSide view

Pin 1: R – Receive from network

Pin 2: T – Receive from network

Pin 3: No connection

Pin 4: R1 – Transmit to network

Pin 5: T1 – Transmit to network

Pin 6: No connection

Pin 7: Optional shield (not used)

Pin 8: Optional shield (not used)

Voice board 
backplate

Connection pinouts
The AG-T1 uses an RJ-48C connector.

LED status
indicators

T1 trunk
interface
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Hardware settings
Do the following procedure as you install voice boards.

To set the I/O address DIP switch

Use these settings as you install the AG-T1 voice boards accord-
ing to the Natural MicroSystems documentation.

Set the I/O address DIP switch on each board as shown 
below.

Software settings
During Unity Setup, do the following procedure when the NMS 
Configurator dialog box appears. 

To enter AG-T1 settings during Unity Setup

a Select a country.

b Change the value of “ISA Interrupt” to “5.”

c Click “Add board.” The Configure Board dialog box appears.

d Type a name for the board in the “Board name” box (for 
example, Board 1).

e In the Board Type list, click “AG T1.”

f In the TAPI Lines list, click “24.”

Continued

Board DIP switch settings I/O address

First board 82C0

Second board A2A0

Third board C2C0

Fourth board E2C0

1 2 3 4 5 6

On
Off

1 2 3 4 5 6

On
Off

1 2 3 4 5 6

On
Off

1 2 3 4 5 6

On
Off
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Natural 
MicroSystems AG-T1 

Continued

voice board

g The value you specify in the Protocol list depends on the 
type of phone system you are connecting the Unity server to.

h In the ISA section, in the Address list, click the I/O address 
that matches the DIP switch setting for this board. For a list 
of settings, see “To set the I/O address DIP switch,” on 
page 155.

i Click “OK” to close the Configure Board dialog box. The NMS 
Configurator dialog box reappears. 

j To add more boards, repeat steps c through i for each 
board.

k Click “OK” to close the NMS Configurator dialog box. 

l Return to the procedure that you were doing when the NMS 
Configurator dialog box appeared.

Phone system Protocol list value

Mitel SX-2000 Digital/Analog Wink-Start

NEC NEAX 2400 Digital Loop-Start (OPS-FX)
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Natural 
MicroSystems 
AG Dual T1 
voice board

Continued

Side view

Pin 1: R – Receive from network

Pin 2: T – Receive from network

Pin 3: No connection

Pin 4: R1 – Transmit to network

Pin 5: T1 – Transmit to network

Pin 6: No connection

Pin 7: Optional shield (not used)

Pin 8: Optional shield (not used)

Voice board 
backplate

Connection pinouts
The AG-T1 uses RJ-48C connectors.

LED status
indicators

T1 trunk
interface

H.100 bus connector
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Natural 
MicroSystems AG 

Continued

Dual T1 voice board

Hardware settings
None.

Software settings
During Unity Setup, do the following procedure when the NMS 
Configurator dialog box appears. 

To enter AG Dual T1 settings during Unity setup

a Select a country.

b Select the first board in the list.

c Click “Configure board.” The Configure Board dialog box 
appears.

d In the Board Type list, confirm that the value is “AG Dual 
T1.”

e In the TAPI Lines list, confirm that the value is “48.”

f The value you specify in the Protocol list depends on the 
type of phone system you are connecting the Unity server to.

g On the Windows NT Start menu, click Programs > 
Command Prompt.

Or on the Windows 2000 Start menu, click Programs > 
Accessories > Command Prompt.

h At the command prompt, type

\<directory that contains NMS files>\bin\blocate

and press ENTER. Values for bus, slot, and interrupt 
appear.

i Make note of the values for bus and for slot.

j Type Exit and press ENTER to close the command prompt 
window.

k Verify the values for bus and slot.

Phone system Protocol list value

Mitel SX-2000 Digital/Analog Wink-Start

NEC NEAX 2400 Digital Loop-Start (OPS-FX)
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l Click “OK” to close the Configure Board dialog box. The NMS 
Configurator dialog box reappears.

m If more than one AG Dual T1 board is installed, select the 
next board in the list of boards, and repeat steps c 
through l for each board.

n If the Unity server also contains AG-T1 boards, do the proce-
dure “To enter AG-T1 settings during Unity Setup,” on 
page 155. 

Otherwise, click “OK” to close the NMS Configurator dialog 
box, and return to the procedure that you were doing when 
the NMS Configurator dialog box appeared.
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Voice 
Technologies 
Group 
VoiceBridge 
2000 
feature-set 
board

Side view

Top view

SC bus connector

Voice board backplate
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Use the Voice Technologies Group VoiceBridge 2000 feature-set 
board with the Dialogic D/160SC voice board to provide fea-
ture-set integration on Mitel SX-200 and SX-2000 phone sys-
tems.

All of the D/160SC and VoiceBridge 2000 boards that you are 
installing must be in the same box because they all must be con-
nected with an SC bus cable. If there are not enough slots in the 
Unity server, then you must put all of the boards into an expan-
sion chassis.

Hardware settings
The IRQ for VoiceBridge 2000 boards is 5 on all Unity turnkey 
systems except the Dell 2400. On the Dell 2400, the IRQ for 
VoiceBridge 2000 boards is 10.

The base addresses for VoiceBridge 2000 boards on turnkey 
systems are 220, 224, 228, 22C, 230, and 234.

Software settings
At the end of the Unity Setup program, do the following proce-
dure when the VoiceBridge Configuration Manager window 
appears. 

To enter VoiceBridge 2000 settings during Unity Setup

a If the Unity server or an expansion chassis contains more 
than one VoiceBridge 2000 board, add boards to the Voice-
Bridge Configuration Manager window. On the VoiceBridge 
Configuration Manager menu, click Action > Add until the 
window lists as many VoiceBridge 2000 boards as are 
installed. 

b Click the first board in the list.

c On the VoiceBridge 2000 Configuration menu, click Action > 
Configure. 

d Click the Board tab. 

e Find the serial number of the board on the “Voice board 
worksheet,” on page 68. Type the serial number of the board 
in the “Serial identifier” box. Then type the base address of 
the board in the “Base address” box.

Continued
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Voice Technologies 
Group VoiceBridge 
2000 feature-set 

Continued

board

f Click the Bus Settings tab.

g If this is board number 1, click “Master.” 

If this is any other board, click “Slave.”

h To accept the settings for the board, click “OK.” 

i If more than one VoiceBridge board is installed, click the 
next board in the list of installed VoiceBridge 2000 boards, 
and repeat steps c through h.

j To save the configuration, click “Save” on the File menu.

k On the VoiceBridge 2000 Configuration menu, click 
Service > Start to start the VoiceBridge 2000 service.

l After the service starts, an Info dialog box appears with the 
message “VoiceBridge 2000 service started OK.” Click “OK.”

m To exit the VoiceBridge Configuration Manager, click “Exit” 
on the File menu.

n In the Windows toolbar, click “Dialogic D/SC Configuration” 
to display the Dialogic D/SC Configuration window.

o Do the procedure “To enter Dialogic settings during Unity 
Setup,” on page 131.
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Shutting down 
and starting 
Unity

Unity is a Windows NT/2000 service that is configured to start 
automatically when the server starts. You also can start and 
shut down Unity by using the Status Monitor, a separate appli-
cation that also provides information about ports, licenses, and 
reports.

To shut down Unity

a If you are at the Unity server, log on to Windows NT/2000 as 
a Unity administrator.

If you are at another computer, skip to step b.

b If you are at the Unity server, double-click the desktop 
shortcut to the Status Monitor.

If you are at another computer, start Internet Explorer and 
go to http://<server name>/status. If prompted, type 
the Unity Administrator name and password (by default, 
Administrator and 12345 on a Unity turnkey system).

c Indicate a shutdown method: Unity shuts down after all 
calls are finished, or Unity interrupts calls in progress with 
a message, disconnects all calls, then shuts down.

d Click “Shut down.” On the Unity server, an “X” appears in 
the Unity icon in the status area of the taskbar when Unity 
has finished shutting down.

To shut down or restart the Unity server 

a Shut down Unity by using the previous procedure.

b On the Windows Start menu, click “Shut down.”

3

4
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c Click “Shut down the computer” or “Restart the computer.” 

During a restart, Unity starts automatically.

When Unity starts successfully, three tones play and a 
check mark appears in the Unity icon in the status area of 
the taskbar.

When Unity does not start successfully, two tones play and 
an “X” appears in the Unity icon in the status area of the 
taskbar.

Continued
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Shutting down and 

Continued

starting Unity
To start Unity

Because Unity starts automatically when you turn on or restart 
the server, you do this procedure only if you shut down Unity 
but did not restart the server.

Exchange must be running before you start Unity. Like Unity, 
Exchange starts automatically when you turn on or restart the 
server. If you stopped Exchange manually but did not restart the 
server, start Exchange before doing this procedure.

a If you are at the Unity server, log on to Windows NT/2000 as 
a Unity administrator.

If you are at another computer, skip to step b.

b If you are at the Unity server, double-click the desktop 
shortcut to the Status Monitor.

If you are at another computer, start Internet Explorer and 
go to http://<server name>/status. If prompted, type 
the Unity Administrator name and password (by default, 
Administrator and 12345 on a Unity turnkey system).

c Click the System Status icon.

d Click “Start.”

When Unity starts successfully, three tones play and a 
check mark appears in the Unity icon in the status area of 
the taskbar.

When Unity does not start successfully, two tones play and 
an “X” appears in the Unity icon in the status area of the 
taskbar.

e If you are at the Unity server, press CTRL+ALT+DELETE, 
then lock or log off of Windows NT/2000 to prevent access 
by unauthorized users.  

TIP

From the Unity server, you also

can start and shut down Unity by

right-clicking the Unity icon in

the status area of the taskbar,

then clicking “Start Unity” or

“Stop Unity.”
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Using the Unity 
Administrator 

The administration interface is called the Unity Administrator. It 
is a Web site that is accessed with Internet Explorer version 4.01 
or later. (Earlier versions of Internet Explorer are not supported, 
and Netscape Navigator is not supported.) 

WARNING! Do not use the “Back” button in Internet Explorer to 
return to a page that you viewed earlier. Instead, use the links in 
the Unity Administrator navigation bar.

WARNING!

To access the Unity Administrator

a If you are at the Unity server, log on to Windows NT/2000 as 
a Unity administrator. 

If you are at another computer, skip to step b.

Click to start procedural and conceptual Help.

Click to display links for field descriptions. Question
mark links appear by the fields that have descriptions.

Click to return to the top level,
which lists the page groups.

Enter data in fields
on the page.

Click a link to move from one
page to another within a

group of pages.

Media Master control bar
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b If you are at the Unity server, double-click the desktop 
shortcut to Unity Administration.

If you are at another computer, start Internet Explorer and 
go to http://<server name>/saweb. If prompted, type the 
Unity Administrator name and password (by default, on 
turnkey systems, Administrator and 12345).

To exit the Unity Administrator

a Click “Log off” at the bottom of the Unity Administrator 
navigation bar.

NOTE: If you close Internet Explorer without first clicking 
“Log off,” it takes about 20 minutes for your logon connection 
to terminate. 

b If you are at the Unity server, press CTRL+ALT+DELETE, then 
lock or log off of Windows NT/2000 to prevent access by unau-
thorized users.

Security
The Unity Administrator relies on the Windows NT/2000 chal-
lenge and response to authenticate the user name and password 
in the background. You may or may not be asked for a name and 
password when accessing the Unity Administrator, depending on 
which account you used to log on to Windows NT/2000 and 
which domain you are logging on from. If you are prompted for a 
name and password, you will be prompted again the first time 
you display a page that contains a Media Master control bar. 
When the Unity Administrator has been inactive for 15 minutes, 
you must exit and restart Internet Explorer to reaccess the Unity 
Administrator.

Once a user has been authenticated, Unity checks that the 
user’s class of service allows access to the Unity Administrator. 
(This is set on the Subscribers > Class of Service > System 
Access page.)

NOTE: To prevent unauthorized users from making changes, 
when you are not working at the Unity server, lock or log off of 
Windows NT/2000.
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Using the 
Status Monitor

The Status Monitor is a Web site that allows you to view 
real-time information about Unity, such as port status. You also 
use the Status Monitor to shut down and start Unity. (See “Shut-
ting down and starting Unity,” on page 163.)

The Status Monitor requires Internet Explorer version 5 or later. 
(Earlier versions of Internet Explorer are not supported, and 
Netscape Navigator is not supported.)  

To access the Status Monitor

a If you are at the Unity server, log on to Windows NT/2000 as 
a Unity administrator.

If you are at another computer, skip to step b.

b If you are at the Unity server, double-click the desktop 
shortcut to the Status Monitor.

If you are at another computer, start Internet Explorer and 
go to http://<server name>/status. If prompted, type 
the Unity Administrator name and password (by default, 
EAdministrator and 12345).

c If you are at the Unity server, when you are finished press 
CTRL+ALT+DELETE, then lock or log off of Windows 
NT/2000 to prevent access by unauthorized users.

Click to see the Port Status page.

Click to see the Report Status page.

Click to see the System Status
page.

Click to start Unity.

Click to shut down Unity.

Click to see the License Status page.

Click to see the Disk Drive 
Status page.

Click to see the Fax Status page.

TIP

If you are at the Unity server and

if the Unity Administrator is run-

ning, you can view the Status

Monitor in a separate instance of

Internet Explorer. Right-click the

Unity icon in the status area of

the taskbar, and click “Launch

Status Monitor.”
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Security
Like the Unity Administrator, the Status Monitor relies on the 
Windows NT/2000 challenge and response to authenticate the 
user name and password in the background. You may or may 
not be asked for a name and password when accessing the Sta-
tus Monitor, depending on which account you used to log on to 
Windows NT/2000 and which domain you are logging on from. 
When the Status Monitor has been inactive for 15 minutes, you 
must exit and restart Internet Explorer to reaccess the Status 
Monitor.

Once a user has been authenticated, Unity checks that the 
user’s class of service allows access to the Status Monitor. 
(This is set on the Subscribers > Class of Service > System 
Access page.)

NOTE: To prevent unauthorized users from making changes, 
when you are not working at the Unity server, lock or log off of 
Windows NT/2000.
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Dialogic voice boards. See voice boards
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domains
establishing trust relationships 56
name of default Windows NT/2000 14

E

e-mail clients and voice message access 6
establishing Windows NT/2000 trust relationships 

56
Example Subscriber, using as a test subscriber 92
Exchange

adding Services Account Administration 
permissions 58

configuring 61
installing 60
networking servers 7
Unity site name 14
when reinstalling on turnkey systems is 

required 14
working with Unity 5

exiting the Unity Administrator 169
expansion chassis 40
exporting information from Repartee or Replay Plus 

31
external number access, testing 95

F–G

fax boards
adding or changing 100
AG 2000 150
CP4/LSI Series 1 138
CP4/LSI Series 2 140
CPD/220 142
CPi/200 144
CPi/200 PCI 146
CPi/400 PCI 148
expansion chassis 40
installing in component systems 35
reseating in turnkey systems 34

supported 33
fax ports, setting up for ActiveFax 75
fax server software, working with Unity 5
feature-set boards

finding I/O addresses for VoiceBridge 2000 
boards 67

supported 33
VoiceBridge 2000 160

forward. See call forward to personal greeting

H

hangup detection, testing Unity 97
hunt groups

programming 91
simulating 91
testing 98

I –K

icons, on/off status 164
identified subscriber messaging, testing 98
illustrations

Status Monitor 170
Unity Administrator 168
Unity installation 6
voice board slots 38

installation task lists
ActiveFax on a separate server 25
unified messaging in an existing Exchange site 

23
unified messaging, one Exchange server 20
voice mail only 16
voice mail with LAN administration 18

installer's checklist 28
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Acrobat Reader on Unity server 64
ActiveFax 69
Exchange 60
Microsoft Data Access Components (MDAC) 63
Outlook 62
Symantec pcAnywhere and Norton Utilities 64
Unity 69
voice or fax boards in component systems 35
VoiceBridge 2000 boards, finding I/O addresses 

67
Windows NT/2000 Server 49

integrations
analog 41
available 90
serial 41
testing 92

interface
Status Monitor 170
Unity Administrator 168

Internet Explorer, working with Unity 5
Internet Information Server, working with Unity 5
IP address

assigning static to the Unity server 47
confirming that the Unity server is getting 54

L

LAN. See network

M

member servers, Windows NT 14
message waiting indication, testing 97
Microsoft Data Access Components (MDAC), 

installing 63
MWI. See message waiting indication

N

NetWare 7
network operating systems 7
networks

assigning a static IP address to the Unity server 
47

confirming that the Unity server is getting an IP 
address 54

NMS fax boards. See fax boards
NMS voice boards. See voice boards
Norton Utilities, installing 64

O

Outlook
installing 62
setting up a profile for the Administrator 

account 80
working with Unity 5

P–Q

passwords
changing, turnkey systems 45
Unity Administrator 169

pcAnywhere, installing 64
peripheral devices, connecting to Unity server 42
permissions, adding Services Account 

Administration 58
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phone systems
connecting to Unity server 42
entering port settings 86
hunt groups 91
integrations 41, 90
Ports page 88
programming 90
selecting information 86
Switch page 86
testing call forward to personal greeting 97
testing external number access 95
testing identified subscriber messaging 98
testing message waiting indication 97
testing release transfers 94
testing supervised transfers 95
testing the hunt group 98
testing the integration 92
testing voice messaging ports 94

ports
settings 88
testing 94
Unity Administrator page 88
viewing status 96

primary domain controllers, Windows NT 14
programming the phone system 90

R

registry, backing up 82
reinstalling software on turnkey systems 14
release transfers, testing 94
repair disk, creating an emergency 82
Repartee, exporting subscriber information from 31
Replay Plus, exporting subscriber information from 

31
reseating voice or fax boards in turnkey systems 34
resources for installation 2
restarting the Unity server 164

S

security
Status Monitor 171
Unity Administrator 169

serial integrations 41
server name, default Windows NT/2000 14
Services Account Administration permissions, 

adding 58
setting up. See installing
Setup program, Unity and ActiveFax 69
shutting down

Unity 164
Unity server 164

sites, Exchange
default name of Exchange site on Unity turnkey 

system 14
Unity in a multisite Exchange network 7

starting
Unity 166
Unity server 164
Unity server and logging on to Windows 

NT/2000, turnkey systems 44
Status Monitor

accessing 170
illustration 170
Ports page 96
security 171
shutting down Unity 164
URL 170

supervised transfers, testing 95
switch. See phone systems
Symantec pcAnywhere and Norton Utilities, 

installing 64
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system key
about 40
attaching to the Unity and ActiveFax servers 42
upgrading 112

T

task lists for installation
ActiveFax on a separate server 25
unified messaging in an existing Exchange site 

23
unified messaging, one Exchange server 20
voice mail only 16
voice mail with LAN administration 18

telephone switch. See phone systems
telephone system. See phone systems
testing

assigning an extension to the test subscriber 
92

call forward to personal greeting 97
external number access 95
hangup detection by Unity 97
hunt group 98
identified subscriber messaging 98
integration 92
IP address for the Unity server 54
message waiting indication 97
release transfers 94
supervised transfers 95
voice messaging ports 94

trust relationships, establishing Windows NT/2000 
56

turnkey systems
about 14
changing passwords 45
default settings 14
reseating voice and fax boards 34
when reinstalling software is required 14

U

unified messaging in an existing Exchange site
characteristics of 12
task lists for installing 23

unified messaging, one Exchange server
characteristics of 11
task lists for installing 20

Unity
See also Unity server
component systems, about 15
configurations 10
configuring to work with the phone system 86
documentation available on compact disc 64
installation illustration 6
installer’s checklist 28
installing 69
interface 168
requirements for account used to install 69
shutting down 164
software components 5
starting 166
testing hangup detection 97
turnkey systems, about 14
upgrading 100
when reinstalling on turnkey systems is 

required 14
Unity Administrator

exiting 169
illustration 168
security 169
URL 169
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Unity server
See also Unity
assigning a static IP address to 47
attaching peripheral devices to 42
attaching the system key 42
confirming that the server is getting an IP 

address 54
connecting phone system to 42
connecting to uninterruptible power supply 40
location of 42
restarting 164
setting up 40
shutting down 164
starting and logging on to Windows NT/2000 

(turnkey systems) 44
system key 40

UnitySite 14
upgrade, exporting data from Repartee or Replay 

Plus 31
upgrading

ActiveFax 100
system key 112
Unity 100
voice or fax boards 100

URLs
Status Monitor 170
Unity Administrator 169

V

ViewMail for Outlook 5
voice boards

adding or changing 100
AG 2000 150
AG Dual T1 157
AG-T1 154
D/120JCT-LS 127
D/160SC 129
D/160SC-LS 132
D/240PCI-T1 136
D/41D 116

D/41E PCI 119
D/41ESC 121
D/41ESC-Euro 124
expansion chassis 40
installing in component systems 35
reseating in turnkey systems 34
supported 33

voice mail only
characteristics of 10
task lists for installing 16

voice mail with LAN administration
characteristics of 10
task lists for installing 18

VoiceBridge 2000 feature-set board 160
finding I/O addresses for 67

W–Z

Web administration
Status Monitor 170
Unity Administrator 168

Web browser, using to administer Unity 168
Windows NT/2000

Administrator account 58
challenge and response 169, 171
creating an emergency repair disk 82
default domain name 14
default server name 14
establishing trust relationships 56
installing 49
logging on (turnkey systems) 44
requirements for account used to install Unity 
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when reinstalling on turnkey systems is 

required 14
working with Unity 5
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